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1 INTRODUCTION 
 

1.1 THE BIRTH OF THE YAMAHATM
 CS-80 

 
Yamahatm was created at the end of the 19th century, in Hamamatsu, Japan.  
 
The first electronic instrument, the Electone D-1 electronic organ, was designed and built in 
1959. But the history of the CS-80 began when, in 1974, the GX-1 was released.  
 

 
The GX-1 

 
The GX-1 was an analog polyphonic synthesizer that was built in order to test the market. It 
costed $60,000 and was premiered in the US in 1973 at the NAMM convention. Keith Emerson, 
John Paul Jones of Led Zeppelin, Jurgen Fritz of Triumvirat and Stevie Wonder all bought one. 
Stevie Wonder called it “the Dream Machine”.  
 
One of the strong features of the GX-1 is the superposition of the two full-sized velocity-
sensitive keyboards. The CS-80V2, with the Multi mode, allows the creation of the same type 
of sounds that the GX-1 offered. 
 
In 1976, Yamahatm introduced the CS-80, which has the same circuits as the GX-1. The price 
tag ($6,900) put it out of the reach of most musicians, and the weight (83 kg with stand) 
made it sometimes hard to use on stage. 
But the qualities of this synthesizer, considered Japans first great synthesizer, made it 
immediately famous in the Music Industry.  
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The CS-80 

 
The CS-80 was made popular in the late 70’s and early 80’s by a number of pop groups, 
including Electric Light Orchestra, Toto, Paul McCartney and Wings. Other artists and bands 
like Vangelis, Bon Jovi, Jean-Michel Jarre, Geoffrey Down, Stevie Wonder and some others 
managed to turn the CS-80 into a real myth.  
 
Let us quote Matt Friedmann from the Vintage Synth Explorer website:  
“No synth sounds greater. The best examples for its extremely fat sound are ‘Blade Runner’, 
‘Mask’, or ‘Bounty’ by Vangelis as well as ‘Dune’ by Toto. (…) 

With two analog oscillators per voice, the CS-80 has the potential for some really phat sounds. 

A great VCF filter with independent hi pass and low-pass resonant filters, a powerful ring 
modulator and plenty of modulation controls further enhance the CS-80's sonic potential. 

There are 22 preset sounds (6 user) selected from bright and ugly colored buttons above the 
keyboard. The keyboard is weighted and has a full 61 keys with performance controllers for 

vibrato, pitch, brightness and volume. Surprisingly there's also a ribbon controller for the 
pitch-bending. There is no MIDI or CV/Gate.” 
 
The first edition of the service manual has a lot of hand-drawn pages, including the main panel 
layout.  
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The CS-80 Service Manual 

 
In conclusion, let’s also quote another huge reference in the field: Peter Forrest (in the A-Z of 
Analogue Synthesizers, Susurreal, First published 31/10/96):  
“When it comes to trying to decide which of the top-flight synths is the best ever, it’s not easy. 
From almost any practical viewpoint, and in terms of versatility of sound, there are a lot of 
instruments which wipe the floor with the CS-80. But if you are looking at richness of sound 

coupled with performance power, and sheer overkill, maybe nothing can touch it. 
 
The CS-80V2 provides all the features of the original CS-80. But it offers also a unique Multi 
mode and a modulation matrix to create entirely new sounds. It also comes with a wide 
selection of presets.  
 
We hope you will enjoy it as much as musicians enjoyed playing the original.  
 

1.2 WHY A VIRTUAL CS-80? 

 
Only 3,000 CS-80 synthesizers were manufactured. Weighing in at more than 80 kg, it takes 
at least two people to move it. And even though few have had the occasion to own one, it 
remains a favorite among musicians and amateurs alike. Some famous artists have gone as far 
as buying several, to have a permanent stock of spare parts. 
 
Why such a success? With two independent lines of synthesis, the CS-80 offers an original 
structure, at the same time simple and rich. The ergonomics of the machine offered an 
approach that inspired musicians: moving a knob, modifying a wheel can be enough to 
radically transform a sound.  
 
But this synthesizer, reproduced identically, despite its particular structure would bring little 
innovation to today’s musical landscape.  
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Arturia has thus brought new life to the myth, remaining faithful to the sound and the 
functionality, but also taking it several steps further. As you will see, these new additions bring 
a new lease of life to the CS-80V2.  
 
The possibility to affect a different sound to each of the polyphonic voices, an independent 
keyboard management, positioning in stereo space and particular tuning allow the 
amplification of the unique presence and the sonorities of this polyphonic synthesizer. New 
combinations have emerged, and the Multi mode will open enormous perspectives for those 
who take the time to discover its characteristics.  
 
To this we have added a modulation matrix, which widens the possibilities of creative 
combinations. 
 
A new version which respects the past while bringing the possibilities of the present and 
future, this was our vision for this CS-80V2.  
 

1.3 A BETTER EMULATION THANKS TO TAE® 
 
TAE® - True Analog Emulation - is a new technology dedicated to the digital reproduction of 
analog circuits used in vintage synthesizers. 
 
When implemented in software code, TAE® algorithms guarantee the respect of hardware 
specifications. This is why your CS-80V2 offers an unparalleled quality of sound.  
 
In detail, TAE® regroups four major advances in the domain of synthesis: 
 

1.3.1 Aliasing-free oscillators 

 
Standard digital synthesizers produce aliasing in high frequencies, and also when using Pulse 
Width Modulation or FM. 
 
TAE® allows the production of totally aliasing-free oscillators in all contexts (PWM, FM, etc.), 
and at no CPU extra cost.  
 

 
Linear frequency spectrum of an existing well-known software synthesizer 

 

Aliasing 
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Linear frequency spectrum of the CS-80V2 oscillator made with TAE® 

 

1.3.2 A better reproduction of analog oscillator waveforms 

 
The waveforms produced by the oscillators in analog synthesizers are marked by the presence 
of a condenser in the circuits. The discharge of the condenser results in a light bend in the 
original waveform (notably for sawtooth, triangular and square waveforms). TAE® allows the 
reproduction of this condenser discharge. Underneath is the analysis of a waveform from the 
original CS-80 original, and that of the CS-80V2. They are both equally deformed by the CS-80 
low-pass and high—pass filtering. 
 

 

 
Temporal representation of a sawtooth waveform,  

deformed by high-pass and low-pass filtering, of the original CS-80 
 

 
Temporal representation of a sawtooth waveform,  

deformed by high-pass and low-pass filtering, reproduced by TAE® 
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What’s more, the original analog oscillators were unstable. In fact, their waveform lightly 
varied from one period to another. If we add to this the fact that the starting point for each 
period (in Trigger mode) can vary with the temperature and other environmental conditions, 
we find one of the characteristics that participated in the typical sound of vintage synthesizers.  
 
TAE® reproduces the instability of oscillators, bringing a “fatter” and “bigger” sound.  
 

1.3.3 A better reproduction of analog filters 

 
TAE® allows the more precise emulation of analog filters over standard digital filters. To obtain 
this result, the TAE® technology is based on the analysis of the analog circuits to be 
reproduced, and converts them in algorithms that faithfully mimic the characteristics of the 
original filters. These curves show the comparison of the original CS-80 filter and that of the 
CS-80V2. 
 

 
Response curve of the 12 dB low-pass filter of the original CS-80 and the CS-80V2 

 

1.3.4 Ring modulator 

 
The CS-80V2 includes a ring modulator, just like the original CS-80. The ring modulator allows 
the application of a waveform (a sine wave) to another, in order to transform it. The result is a 
more brilliant sound, distorted, and enriched in harmonics. As a result of this increase in the 
number of harmonics, standard ring modulation algorithms create an audible aliasing. To avoid 
this unwanted effect, TAE® includes a module for the dynamic control of the amplitude with 
aliasing correction, which removes every trace of aliasing in the signal coming from the ring 
modulator. 
 
 
 
 
 
 
 
 
 

Response curve of the 12 dB 
low-pass filter of the original 
CS-80 
 
 
 
 
Response curve of the 12 dB 
low-pass filter of the CS-80V2 

Amplitude control module 
(VCA) with aliasing 

correction 

Input Output 

Sine wave 
form 



ARTURIA CS-80V2 USER’S MANUAL  10 

 

2 INSTALLATION 
 

2.1 WINDOWS INSTALLATION (XP / VISTA) 

 
Insert the CD-ROM in the drive. Explore the CD-ROM content; double-click on the CS-80V2 
Setup PC.exe icon. 
 

 It is always a good idea to first check if a more up-to-date version is available online; if so, it is safe to install 

directly from the latest update: http://www.arturia.com/evolution/en/downloads/updates.html 

 
At the first step in the installation, choose the folder to install the CS-80V2. It will be installed 
by default in C:\Program Files\Arturia\CS-80V2. 
You can change the destination with the Browse button. 
 

 
Choice of installation folder 

 
The CS-80V2 will be installed as a standalone application. The following step allows you to 
install the CS-80V2 as a plug-in. To do this, choose the protocol(s) that you use (VST, RTAS). 
For more information on these protocols, look at chapter 9. 
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Choosing the protocols 

 
For the VST and RTAS protocols, you need to choose the installation folder to allow the host 
application to use the CS-80V2 as a plug-in. If you do not know how to make this choice, go to 
chapter 9. 
 

 
Installation folder choice for the VST plug-in 

 
The installation program now has enough information to complete the installation. When the 
installation process is completed, please proceed to authorization step (chapter 3).  
 

 If you use a hardware dongle, take care to keep it plugged into your computer as the program will periodically check it. You 
won’t need your license number when you are reinstalling the program; as the license is stored on your dongle. 
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2.2 MAC OS X INSTALLATION 
 
Insert the CD-ROM into the drive. Explore the content of the CD-ROM, and then double click on 
the icon named CS-80V2 Setup.  
 
Follow these steps:  
� Read and accept the End User License Agreement,  
� Select a destination.  
 
When prompted, enter the administrator name and password of your computer in the 
Authentication window.  
 

 
Authentication window 

 
The CS-80V2 can not only be installed as a standalone application, but also as VST, AU and 
RTAS plug-ins.  

 
The installation program now has enough information to complete the installation. When the 
installation process is completed, please proceed to authorization step (Chapter 3).  
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3 AUTHORIZATION 
 
Now your CS-80V2 has been installed, you have to authorize the synthesizer. 
 
Previous versions used an “original CD + license number” protection scheme; however the CS-
80V2 uses the Soft-eLicenser full-software solution. Avoiding the use of a USB port by default, 
this system allows using the synthesizer on one machine which must be connected to the 
Internet during the authorization process. 
 

 To transfer your license on another computer, or simply use the CS-80V2 on several computers (one instance at a 
time), you will need: 

• one USB-eLicenser hardware dongle (sold separately, also used by many other software vendors); 
• follow the License Transfer Wizard inside the eLicenser Control Center. 
This transfer, requiring a valid Internet connection, can be done in both ways: 

• from Soft-eLicenser to USB-eLicenser; 
• from USB-eLicenser to Soft-eLicenser. 
Please check the eLicenser documentation installed on your computer for further details. 

 
Connect your computer to the Internet, and then launch the eLicenser Control Center. This 
application has been automatically installed on your computer; depending on your computer 
operating system it is accessible through: 
 

� Windows: Start > Programs > eLicenser > eLicenser Control Center 
� Mac OS X:  Finder > Applications > eLicenser Control Center 

 

 The screenshots below have been taken on a Mac OS X operating system; however the process is strictly identical 

under a Windows XP/Vista/7 environment. The same functions apply, only the graphical user interface slightly differs. 

 
In the eLicenser Control Center main window you should see a Soft-eLicenser (SeL) virtual 
dongle created onto your computer. 
 

 
eLicenser Control Center main window, showing an empty Soft-eLicenser. 

 
� In the eLicenser Control Center menu, go to Actions > Enter Activation Code. 
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� When prompted, enter the 32-digit Activation Code; this code is written on the plastic card 
attached to your User’s Manual.  

 
� Click on Continue to activate your software. 
 

 
Enter the activation code 

 
� The eLicenser Control Center is now ready to download the software license that will allow 
you to use the CS-80V2. Click on Continue, the progress bar should advance until 
download completion. A popup window will confirm, just click Close, then Finish. 

 

 
License download confirmation window 

 
� Now the eLicenser Control Center main window should show your CS-80V2 license installed 
and activated. 
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License is installed and activated 

 
� It’s now time to launch the CS-80V2 synthesizer. 
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4 QUICK START 
 
This chapter will help you to familiarize yourself with the general usage of the CS-80V2. You 
will be presented with an overview of the different sections of the synthesizer as well as the 
Single voice and Multi mode settings. You will find a precise and detailed description of all 
settings and controllers in the chapters that follow. 
 
Chapter 8 A few elements of sound design will be of particular interest for users who have 
never worked with a subtractive synthesizer, but wish to understand the basics in this domain. 
 

 
The CS-80V2 front panel  

 
 

4.1 USE OF PRESETS 
 
Use of presets is one of the main areas of evolution of the CS-80V2 when compared to the 
original. In fact, the original CS-80 only allowed 4 spaces in memory for saving 4 sounds.  
In the CS-80V2, a preset (memorized sound) contains all parameter settings of the synthesis 
voice (Single), as well as Multi mode parameters and the different real time controllers and 
effects needed to reproduce the sound.  
 
To get to know a few of the different sounds contained in the CS-80V2, we will select the 
preset J.M.B_4Vces_unis. 
 
� For this, click on the button BANK (at the left of the display indicating the name of the bank 
currently in use). By clicking, you will see a dropdown menu indicating the available banks. 
Choose the bank JM.Blanchet.  
When the menu appears, it opens sub menus in a step-by-step manner. This allows us to 
get to the sub-bank and presets of a sound designer with a single click.  

 
� Choose the sub-bank called Basses and finally select J.M.B_4Vces_unis among the presets. 
 

Effects 

Lines I & II 

synthesis 

parameters 

Ribbon controller 

Virtual 

keyboard 

Arpeggiator 

Modulation 

matrix 

Tool bar 

Multimode 

Ring 

modulator 
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Select a preset 

 
The CS-80V2 is shipped with about 800 presets, which will allow you to get to know the 
sounds of the synthesizer. A bank called Templates proposes a selection of presets which allow 
you to work from a basic template when programming a sound.  
 

 It is also possible to view sounds by sub-bank by choosing the option All in the bank. For example, to see all bass 

presets, click on All in the bank selections and then on Bass. 

 
Let’s modify this preset. For this, we’ll begin with a simple modification.  
 
� Modify the brilliance of the preset sound with the brilliance controller on the synthesizer. 
For this, increase or decrease the green linear BRILL knob on the control panel (above the 
virtual keyboard). The tone of the sound will become more or less “brilliant”. Set this knob 
to your convenience. 

 

 
Change the brilliance of the sound 

 
� In the same manner, you can change the range of the oscillator by decreasing the linear 

FEET knob to one of the 6 values expressed in feet like organs. The lower the number, the 
higher the pitch. (The standard tuning can be found at the value 8’) 

 
With these first settings, you have already modified the preset J.M.B_4Vces_unis. You can now 
save the sound that you have just created. 
 
� To save a user preset (User), click on the save icon in the tool bar: the settings of the 
current sound will be saved in the preset being used without changing its name. If the 
current preset is a factory preset, the factory preset will not be replaced.  

 
� To choose another destination for the sound, click on the Save as icon and then choose the 
destination. For example, select New in the choice of banks. 2 new bank and sub-bank 
locations as well as a new preset are immediately created. The names New bank, New sub-
bank and New preset appear in their respective displays.  

 
� Click on each of these displays to customize the name for each of these 3 parts: bank, sub-
bank, and preset. 

 
 

4.2 METHODS OF PLAYING 

 
The CS-80V2 offers 2 playing modes:  
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� The Single mode allows you to play a single sound (here we will call it timbre) 
redistributed across the keyboard. 

 
� The Multi mode allows you to play a group of single timbres distributed across 4 zones on 
the keyboard (Split), or several single timbres superimposed across the keyboard (Unison).  

 

 
The Single mode (similar to the original CS-80) 

 

 
The Multi mode  

 

 The Single mode presents the exact architecture of the original CS-80, which is a single timbre, distributed across 

the whole of the keyboard with an 8 note polyphonic limit. 

The Multi mode takes from the GX1, the “father” of the CS-80, which used 3 keyboards (2 polyphonic and 1 

monophonic) and a separate pedal keyboard to play different sonorities distributed to each of the keyboards. 

 
� To get to the Multi mode, click on the button to open the hatch situated above the 
synthesis parameters. A virtual LED display on the right of the tool bar now indicates Multi 
mode is active. 

 
� To go back to Single mode, simply click on the close hatch button. The LCD display now 
indicates Single. 

 

 
Opening the Multi mode hatch 
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� You also have the option to only keep the keyboard and its assignable controllers visible on 
the screen by clicking on the KBD icon. The advantage being quick access to real time 
controllers and sound presets while having a reduced work area.  
You can activate this reduced mode by clicking on the KBD icon, which is on the right of the 
tool bar. 

 

 
The reduced mode 

 
 

4.3 OVERVIEW OF THE SINGLE MODE (CS-80) 

 
The single mode contains 62 synthesis parameters, which will allow you to create a nearly 
infinite variety of sounds. The controllers associated with these parameters are found 
regrouped in 2 rows just under the Multi hatch.  
 
Each of these 2 rows is composed of: 

� 1 oscillator (VCO), which provides the base audio signal with its 3 waveforms: square, 
sawtooth and triangle. Also, this section allows control of the pitch of the oscillator (the 
frequency) and the impulse width of the waveforms. 

� 1 low frequency oscillator (SUB OSCILLATOR) used to modulate the impulse width. 
� A high-pass resonant filter, tied to the 12 dB / 24 dB cutoff selector. 
� A low-pass resonant filter, tied to the 12 dB / 24 dB cutoff selector. 
� An ADR envelope that modulates the high-pass and low-pass filters. 
� 1 amplifier (VCA) allowing the amplification of the signal coming from the filter to 
direct it to the stereo output. 

� An ADSR envelope modulates the signal going through the amplifier. 
� Velocity and aftertouch settings on volume (VCA) and brilliance (VCF).  

 

 
The synthesis parameters 

 

 A series of 24 buttons of factory presets will give you base examples for the programming of synthesis parameters. 

These presets are found on the control panel. They offer the presets of the original CS-80. 
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Synthesis line presets 

 
Let’s see how to quickly create a polyphonic sound that evolves through time: 
 
To really understand the programming of the CS-80V2, let’s take a very simple sound. Select 
the preset 2VCO_1VCF_Link from the Templates / Filters sub-bank. 
 
� First, set the mix output to first voice as the image below: 
 

 
 
� Start by reducing the cut-off frequency of the low-pass filter (LPF). This will make the 
sound more muted. For this, set the linear green LPF knob. 

 

 
Set the cut-off frequency 

 
Note that the filter cut-off frequency is modulated by an ADR envelope (Attack, Decay and 
Release).  
 
� To really hear the effect from the ADR envelope on the filter cut-off frequency, increase the 
value for the resonance (RES). This will amplify the filtering effect and the sound will start 
to make the cutoff frequency more pronounced, producing a “whistle” effect. 

 
� Change the length of attack for this envelope (A) so that the brilliance increases slower or 
faster when a note is played. 

 
� In the same manner, change the value for the decay (D). The brilliance will also decrease 
faster or slower while you are holding the note. 

 

 
The parameters of the filter envelope 

 
You have probably noticed that a different envelope can also modulate the amplitude of the 
sound (VCA): 
 
� Increase the attack time (A) so that the volume of the sound progressively increases.  
 
� Do the same thing with the release (R); the volume will progressively decrease when you 
release the note. 
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The ADSR envelope controllers 

 
 

4.4 OVERVIEW OF THE MULTI MODE 

 
The CS-80V2 allows the creation of 8 parallel voices and thus, in theory, 8 different sounds 
played at the same time.  
 

 On the original CS-80, a note was controlled by a card that was filled with electronic circuits that represented the 

complete synthesis architecture. It is for this reason that we could, for example, obtain notable differences in the 

settings of a sound between the notes played and the tuning of the oscillator.   

The CS-80V2 conserves this ideal: you can program eight different sounds (eight voices), which are assignable in a 

multitude of applications. 

 
With the Multi mode, it is possible for you to assign each of these 8 voices to 4 keyboard zones 
and to 4 different MIDI channels. These 8 voices can also be superimposed across the entire 
keyboard in order to create a composite sound that is very rich and expressive (Unison mode). 
 
Let’s follow this example: 
 
� Choose the preset Tremolo in the Templates low frequency bank and Effects sub-bank. In 
this example, the 8 voices all have the same settings. 

 
� First, open the Multi mode to access the parameters. 
 
� Now, set the different zones as follows: 

o The first 4 voices will occupy zone1 (C1 to B3); 
o The fifth voice will occupy zone2 (C4 to C5);  
o The sixth voice will occupy zone 3 (C5 to C6) 
o The seventh & eighth voices will occupy the zone 4 (C6 to C7).  
o All these zones must be configured on all MIDI channels by selecting Omni, close to 
the Keyboard range. 

 
� The voice modes allow you to play differently according the voice: 

o Set the UniLast for each voice 
o Deactivate the PORTA, R.MOD and FX buttons for each voice  
o Set the FEET voice to 16”, this will create a bass for the low part of the keyboard. 

 

     
Keyboard and MIDI configuration    Feet configuration 

 
� In order to get a polyphonic voice you have to set number of polyphonic voices in the tool 
bar, x3 is enough for our sound: 

 

 
Set the polyphony 
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� Here you can see the zone assignment: 
 

 
The keyboard zone assignment 

 
� Before changing the different mode parameters, please deactivate the tremolo effect 
(TREM) in the effect zone. 

 
Now let’s apply some change to our sound: 
 
� Start by changing the pan position of the first voice. Place the sound on the right: turn the 
knob PAN fully to the right (value of 1.00R). 

 
� Detune this voice by slightly turning the detune knob (DET) to the right (value of +1.40). 
 
� Now change the pan position of the second single fully to the left (value 1.00L). 
 
� Detune this voice by turning the knob DET to the left (value of +0.9945). 
 
� Apply the same changes to the third and fourth voice. 
 
� Place these 4 voices to unison mode by selecting the UniLast setting in the VOICE MODE 
menu in the edit zone. The sound of the first 4 voices is “deeper” as a result of the 
detuning of the 4 voices, and “widened” as a result of the pan position settings between all 
of the voices.  

 
� The fifth Single placed in zone 2 must now be configured as a Random voice mode. It will 
play a polyphonic accompaniment sound. 

  

 
Random mode 

 
� Activate the ring modulator on this Single to obtain a modulate sound that will be played 
on the second zone.  

 

 
Ring mode activation 

 
Your keyboard now contains 4 different zones: first is a bass, second is a polyphonic keyboard, 
and third and fourth are leads. 
 
You can change the parameters of all the voices as you want, for example, you can change the 
patch of each voice. Then you can play up to 8 different sounds on 4 zones. To do that, just 
click on the patch number close to the zone number. Select your patch and edit it by clicking 
on the red Edit button. 
It’s also possible to define various parameters like arpeggio or the MIDI channel of the zone. 
Below you will find a list of these parameters: 
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For each of the 8 voices, you can set: 
� The choice of zone (from 1 to 4 or no zone) 
� Transposition (in semitones) 
� Fine tuning 
� Volume 
� Pan position  
� Portamento/Glissando 
� Ring modulator 
� Chorus and delay effects 

 

 To quickly isolate a voice (where the EDIT button is lit) and play it across the whole keyboard, just close the Multi 

panel. 

 
For the 4 zones: 

� The MIDI channel (from 1 to 16 and Omni) 
� The low and high notes (from C2 to C8) 
� The playing mode (rotating polyphonic trigger, reassigned, reinitialized, monophonic 
unison) 

� Arpeggio activity 
 

 If you wish to preserve CPU power, avoid using the Rotate mode, rather place the zone on ReAssign mode. 

 
 

4.5 THE REAL TIME CONTROLLERS AND MIDI ASSIGNATION 
 
Like its excellent ancestor, the CS-80V2 is particularly adapted to real time playing. One of the 
major points of evolution when compared to the original is the possibility to assign any CS-
80V2 knob to an external MIDI controller.  
 
Let’s look at an example: 
 
� Click on the brilliance knob (BRILL) while holding down the [Control] key (Windows) or 
[Command] key (Mac). A MIDI assign dialog then appears.  

 
� Click on Learn and move the MIDI controller of your choice (the modulation wheel for 
example). The CS-80V2 knob will move at the same time. 

 
� You can then record the movement of your MIDI controller on your MIDI sequencer or 
simply make it evolve on the fly during a live presentation. 

 

 
MIDI assigning of the Brilliance knob 

 
As you have previously read, the CS-80V2 has a large number of controllers acting on the 
tuning, tone (brilliance) or the volume of a sound: 

� The keyboard receives velocity and polyphonic aftertouch information 
� A ribbon controller lets you continuously control any synthesizer parameter through a 
modulation matrix, the base assignment being oscillator frequency. 
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4.6 THE EFFECTS SECTION  
 
The effects section lets you add Chorus, Stereo Delay or even a Ring Modulator to your sound. 
You can also impose a Portamento/Glissando to what you play on the keyboard. 
 
Settings concerning sustain and expression pedals are also available in this section. 
 

Let’s keep the Tremolo example and see how to use the effects within Multi mode: 
 
� Deactivate the FX button for Single1. We won’t place effects on the bass sound. 
 

 
Sending sound to the effects 

 
� Leave the FX button activated on the singles you want. 
 

 It is important to know that effect settings are the same for all singles with the same patch. 

 
� Activate the ON/OFF switch for Chorus and Delay in the effects section, on the left of the 
virtual keyboard. 

 
� Set the Delay MIX knob to counterbalance the dry sound of the Singles and the return of 
the delay. 

 
� Next turn the Delay SPEED knob to set the speed of the repetitions. 
 
� Finally, set the chorus depth by turning the DEPTH knob. 
 
� You can choose between two types of chorus: Chorus and Tremolo. The Tremolo 
oscillations are faster than those of the Chorus. This effect is ideal for auto pan effects. 

 

 
The effects section 

 
Of course, all of the settings that we have modified during these chapters can be saved in the 
preset that you have created. 
 
 

4.7 THE MODULATION MATRIX 
 
On the left of the synthesis parameters is a second hatch, smaller than the one for Multi mode. 
This contains an extension of the possibilities for modulation when compared to the original 
CS-80. It is presented in the form of a modulation matrix in which we choose 10 sources 
(SubOsc, EG, etc.) which will modulate 10 destinations (VCO 1 Freq, LP 2 res, etc.). 
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The modulation matrix 

 
The choice of source and destination is done by clicking on LCD screens. The individual matrix 
positions will offer 12 modulation sources and 38 destinations, with an attenuation control in 
between. 
 
Let’s apply 2 supplementary types of modulation to the preset 2VCO_1VCF_Link: 
 
� Open the hatch of the matrix to access the parameters. 
 
� Among the modulation sources, choose the first low frequency oscillator (LFO 1). 
 
� Choose the cut-off frequency for the low-pass filter among the destinations by selecting LP 

1 cut. 
 

 
Modulate the frequency of the low-pass filter (LP 1 cut) with the LFO (LFO 1) 

 
� Between the LCD screens is a knob (AMOUNT). It allows you to set the level of modulation 
by applying positive values (by turning to the right) or negative values (by turning to the 
left).  

 

 
Turn the knob to the right for a positive value 

 
� After this modulation is set, the cut-off frequency will vary in a cyclic manner, to the 
frequency of LFO1. You can also set the speed of the Sub Oscillator by changing the value 
of the SPEED button. 
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5 THE INTERFACE 
 

5.1 USE OF PRESETS  
 
Presets let you memorize the sounds of the CS-80V2. A preset contains all of the information 
pertaining to the reproduction of a sound. In the program, the presets are classed in banks 
and sub-banks. Each bank contains a certain number of sub-banks, which generally determine 
a type of sound: sub-bank Basses, sub-bank Effects, etc. Each sub-bank contains within itself 
a certain number of presets. 
 
The CS-80V2 is shipped with several factory banks. But it is possible to create new user banks 
of sounds, each containing a number of sub-banks and presets. For security, the factory banks 
cannot be directly modified. It is nonetheless possible to create a sound based on a factory 
preset by saving it as a user preset. 
 

5.1.1 Choice of a bank, sub-bank, preset 

 
The bank, sub-bank and preset currently in use by the CS-80V2 are each permanently 
displayed in the synthesizer tool bar. 
 

 
Display of current bank, sub-bank and preset 

 
To choose a preset in the current sub-bank, click on the button on the left of the field, and a 
dropdown menu appears with a list of the presets of the same sub-bank. You can choose 
another preset by selecting the corresponding line in the dropdown menu. As soon as the 
preset has been chosen, you can play the new sound on your MIDI keyboard or from your 
sequencer. 
 

 
Choice of a preset in the same sub-bank 

 
In the dropdown menu concerning the banks, the All option allows you to open a sub-list with 
all of the sub-banks available in all of the banks. This gives you access directly to all of the 
presets of a given type, for example all of the basses, no matter which bank they are in. 
 
This function is particularly useful to quickly see all of the presets of the same type. 
 
When a preset has been modified an asterisk appears next to its name in the tool bar. 
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5.1.2 Creation of a bank, sub-bank, preset 

 
To create a new bank, click on the left sided arrow button. The dropdown menu displays the 
names of all of the existing banks of sounds, and a line called New bank... Click on New 
bank... to create a new bank of sounds. You can then change the name of this bank by clicking 
on its name in the tool bar and entering the new name. 
 
To create a new sub-bank, just click on the middle sided button, and select New sub-bank... 
You can also change the name of the new sub-bank. 
 
Finally, to create a new preset, click on the right sided arrow button, and select New preset... 
The new preset is created, recording the current settings of the CS-80V2. You can thus work 
on the settings of a sound, and save the sound again with the same preset name by clicking on 
the save button (see the following paragraph). You can also change the name of the new 
preset by clicking on its name. 
 

5.1.3 Saving a user preset 

 
To save your setting modifications in the current preset, click on the Save button in the tool 
bar of the CS-80V2. 
 

 
Save button in the tool bar 

 
If you want to save your settings under another preset name, click on the Save As button in 
the tool bar. A dropdown menu appears and allows you choose an existing preset (in this case, 
the contents of the existing preset will be replaced with the current settings), or to save your 
settings as a new preset (in this case, click on New preset... in the sub-bank of your choice). 
 

 
Save As button and Save menu in the tool bar 

 
When you are working from a factory preset, which cannot be deleted, clicking on the Save 
button will not replace the current factory preset, but will instead automatically open the Save 
As menu to save the current settings as a user preset. 
 

5.1.4 Import/ Export of a bank of presets 

 
It is possible to import new banks of presets conceived for the CS-80V2. To import a new bank 
of presets, click on the preset bank import button on the tool bar: 
 

 
Preset bank import button on the tool bar 
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When you click on this button, a window appears allowing you to choose the preset bank file 
for the CS-80V2 (as AYS file format). Choose the file that you want to import, and click on 
Open. The new bank of presets will automatically appear among the available banks. 
 
The CS-80V2 equally offers the possibility to export your own sounds to save them, to use 
them on another machine, or to make them available to other users.  
It is possible to export a preset, a sub-bank, or a complete bank. 
To export the current bank, sub-bank, or preset, click on preset bank export button in the tool 
bar of the program: 
 

 
Current preset bank export button in the tool bar 

 
Select the type of export that you want to perform (bank, sub-bank or preset) and a window 
will appear, giving you access to a choice of destination folder and file name for the bank that 
you are exporting. 
 
 

5.2 USING CONTROLLERS 
 

5.2.1 Sliders 

 
The sliders are the most frequently used controllers on the CS-80V2. They are simple to move 
with a click on the cursor and a vertical mouse movement. It is also possible to use finer 
settings with a right click on Windows, or [Shift]+click on Mac OS X. 
 

  
Sliders 

 

5.2.2 Knobs  

 
Generally the sequencers offer several knob control modes. 
The default mode of control for knobs with the mouse is the circular mode: click on the knob 
and turn around it in order to change the value of the controller. The circular mode gives high 
precision in the manipulation of controls: The further the mouse goes from the knob, the 
higher the precision of the setting. 
 

 
Circular knob 

 
In linear mode, the knob can be set only by vertically moving the mouse, not going around it. 
Like the sliders, it is possible to obtain a higher precision by right clicking or [Shift]+click on 
the knob concerned. 
 
The linear mode can sometimes be simpler to use than the circular mode, although we can 
lose in precision (the precision is limited by the number of vertical pixels on the screen on 
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which the mouse movements are being evaluated). Movement to linear mode is available in 
the options of your sequencer. In Cubasetm, for example, this choice can be found via the Edit 
> Preferences menu, and is found in the General tab of the window. 
 

5.2.3 Switches  

 
The CS-80V2 has several types of switches. Simply click on these switches to change their 
state.  
 

    
Switches 

 

 The rocker type switch is On when in the lowered position. 

 

5.2.4 Ribbon 

 
The ribbon by default controls the pitch bend of the synthesizer. Simply click on the ribbon 
while playing a note on the master keyboard or in the sequencer, and move the mouse 
horizontally to change the pitch. Just like a spring-loaded dial, the ribbon comes back to its 
initial position once the mouse has been released. 
 

 
The ribbon controller  

 

5.2.5 Setting keyboard zones 

 
Setting keyboard zones allows defining a zone on a master keyboard. This presents two 
displays: one for the minimum limit of the zone, and one for the maximum. To modify these 
values, simply click on the value and vertically move the mouse. 
 

 
Keyboard Zone settings 

 
There is another solution for easier definition of keyboard zones. Just double-click on the zone 
to be modified, and a mini keyboard will appear on the screen. 
 

 
The mini keyboard makes zone settings easier 

 
We can define a zone by simply clicking on the keyboard, a left click modifies the minimum 
limit, and a right click or [Shift]+click modifies the maximal limit. The white zone on the 
keyboard represents the active zone. 
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5.2.6 Virtual Keyboard 

 
The keyboard allows you listen to the synthesizer sounds without the need for an external 
master MIDI keyboard, and without programming a melody in the sequencer. Just click on a 
virtual key to hear the corresponding sound.  
 

5.2.7 MIDI control 

 
One of the major points of evolution when compared to the original is the possibility to assign 
any CS-80V2 knob to an external MIDI controller.  
 
Let’s look at an example: 
 
� Click on the BRILL knob while holding the [Ctrl] key down. A MIDI assign dialog appears.  
 
� Click on Learn and move the MIDI controller of your choice (the modulation wheel for 
example). The CS-80V2 knob will move at the same time. 

 
� You can then record the movement of your MIDI controller on your MIDI sequencer or 
simply make it evolve on the fly during a live presentation. 

 

 
MIDI assigning of the BRILL knob 

 
As you have previously read, the CS-80V2 has a large number of controllers acting on the 
tuning, tone (brilliance) or the volume of a sound: 

� The keyboard receives velocity and polyphonic aftertouch information 
� A ribbon controller allows you continuously control any synthesizer parameter through 
a modulation matrix, the base assignment being oscillator frequency. 

 
Most of the knobs, sliders and switches on the CS-80V2 can be manipulated with external MIDI 
controllers. Before anything else, make sure that the MIDI device that you wish to use is 
correctly connected to the computer, and that the sequencer or the CS-80V2 application is 
correctly configured to receive MIDI events coming from the device. 
 
Every instance of the CS-80V2 receives MIDI events transmitted on a given channel. This 
reception channel is defined in a global manner for the synthesizer, either in your sequencer, 
or in the independent CS-80V2 application (see the corresponding chapters). On the reception 
channel, the CS-80V2 can receive up to 120 different MIDI controls. It is possible to choose a 
reception control for each knob. For this, click on the knob that you wish to control while 
holding down the [Ctrl] key. A configuration window appears and will allow you to choose a 
MIDI control number. You can also click on the Learn button and move one of your physical 
MIDI controllers. In this case, the control number will be detected and configured 
automatically. To deactivate the MIDI control of a knob, simply uncheck the Active option in 
the MIDI control window. 
 
The CS-80V2 provides a new type of control: the NRPN mode. With this mode you will be able 
to affect a nearly infinite number of controls. To do that, configure your MIDI device with the 
NRPN mode and display the MIDI assign dialog box. The CS-80V2 will immediately recognize it 
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by ticking the NRPN box (see above). If you have difficulty with the NRPN setup, please 
contact the technical support of your MIDI device. 
 
 

5.3 THE SOUND MAP 

 
The sound map is an innovative preset explorer which offers an easy and funky way to locate 
and choose a preset on a map area to simplify the preset management and to quickly find the 
appropriate sounds. 
The sound map also offers brand new interface for creating new sounds thanks to a morphing 
feature between four presets. 
 
The Sound Map offers three views: 

� The MAP main interface: the sound map classifies the presets thanks to statistic 
methods in order to organize the sounds on a map from their own audio 
characteristics.  

� The LIST presets list: this page offers a more classical interface to classify the presets 
using lists and filters to find the desired sound. 

� The COMPASS morphing interface: this page allows creating new sounds in real time 
thanks to a morphing result with up to 4 presets. 

 
� To open the main Sound Map interface, click on the SOUND MAP button located on the tool 
bar. A new window appears over the CS-80V2 main interface. 

 

 
Open the main Sound Map interface 

 
� To open the preset list page, click on the LIST button, on the top right of the sound map 
interface 

 
Open the List interface 

 
� To open the preset morphing page, click on the COMPASS button. 
 

 
Open the Morphing interface 

 
� To return back on the main sound map interface, click on the MAP button 
 

 
Return back on the map interface 
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5.3.1 The MAP main interface 

 
The sound map interface shows a map where are shared out all the presets of the  
CS-80V2 organized for their types of sound and their own audio characteristics. 
 

 
The Map interface 

 
The types of presets are represented by different geometrical characters and colors for an easy 
way to locate them: 
 

 “Bass” sounds 
 
 “Brass” sounds 
 

 “EFX” sounds 
 
 “FM” sounds 
 

 “Guitar” sounds 
 
 “Keyboard” sounds 

 

 “Lead” sounds 
 
 “Pad” sounds 
 
 “Percussive” sounds 
 
 “Sequence” sounds 
 
 “Strings” sounds 

 
 “Others” sounds 

 
� To select and to listen a preset, directly click on one of the icons, anywhere you want on 
the map area. The icon is now highlighted in red. If you hold a few seconds on the selected 
preset, a popup appears and indicates the name of the preset.  
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Select a preset 

 
You can create new presets thanks to an exclusive real time morphing feature:  
 
� Click between a group of presets and hold the left button of the mouse on this point. Four 
red arrows drawing a cross appear linking the group of four presets.  

 

 
Morphing between a group of presets 

 
� You can now drag your mouse between those presets. The green arrow shows you the 
starting point of your motion.  

 
� When you release the left mouse button, you can play the resulted sound and, if you wish, 
you can save it on a CS-80V2 user bank. 

 
By this way it is very easy to quickly get some new and exiting sounds without programming 
anything on the synthesizer interface. 
 

The Sound Map overview 
On the top right of the Sound Map main interface, you can see an overview of this map. 
You can use the map overview for navigating into the map and to zoom in or out inside of the 
map area.  
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The map overview interface 

 
� To navigate into the map, click inside of the red square and drag it on the map area to 
view other sections of the Sound map. 

 
� To zoom in the view on the sound map, click on the Zoom slider, under the overview 
window, and drag it on the right to increase the size of the map.  

 
� To zoom out the view on the sound map, click on the Zoom slider, and drag it on the left to 
decrease the size of the map. 

 

 
The zoom slider 

 

 You can also use the “ZOOM +” or “ZOOM -” buttons, under the slider, to increase or decrease the map size step 

by step (by factor 1). 

 
� Click on the FIT ZOOM button allows resizing the map to its global size. 
 

 
The FIT ZOOM button 

 

The instrument type filter window 

On the right of the map main interface, an instrument type filter window allows you to choose 
which type of preset you want to see (or to hide) on the map. By default, all types of presets 
are selected.  
 

 
The instrument type filter 
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To select an individual or a group of instrument types: 
 
� First click on the All button, on the bottom of the type filter window: this will hide all the 
instrument types from the sound map. 

 

 
The ALL button 

 
� Then, select the type(s) you want to see by clicking on the corresponding square box(es). 
A nock appears on the selected box(es) and the type(s) of presets appears on the map 
interface.  

 

 
Show pad presets 

 
This is a good way to simplify and to refine the preset search.  
 
� If you click again on the All button, all types of presets will be displayed on the map.  
 

Preset snap shot memories 

You can select up to four presets, anywhere on the map interface, and save them on up to four 
snap shot memories. You will be able to use those four presets on the COMPASS view to create 
new sounds by morphing feature (see below for more details on this feature). 
Of course, you can save any kind of type of presets on these four snap memories.  
 

 
Select a snap memory 

 
To save a preset on a snap memory:  
 
� Select a preset on the sound map main interface.  
 
� Hold the [Shift] key and select one of the four snap memory button. The snap memory 
button is now highlighted in red. 

 
� Repeat the same actions if you wish to save presets on the three other snap memories. 
 
� When all memories already contain a saved preset, you can replace them with other 
presets. 

 
� Select another preset anywhere on the Sound Map interface, click on any of the 4 snapshot 
buttons while pressing the [Ctrl] key. 

 

5.3.2 The LIST preset manager 

 
The list preset manager offers a more classical way to explore the presets using a list interface 
in which the presets are classified and filtered in order to simplify preset management. 
 
� To open the list interface, click on the LIST button located on the toolbar of the Sound Map. 
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Click on the LIST button 

 
The list preset interface is very simple, you can see three columns showing, from left to right: 

� The preset names 
� The instrument type 
� The name of the sound designers 

 

 
Preset list interface 

 
All those data are classified by alphabetical order.  
 
� To select a preset, simply browse the list and click on the name of a desired preset. 
 
� You can inverse the order (from A to Z or from Z to A) by clicking on the column title: an 
ascendant or descendant arrow shows you the order type. 

 

 
Inverse the order of the instrument types 
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5.3.3 The COMPASS morphing interface 

 
The Morphing page is an independent module allowing you to quickly create some new sounds 
thanks to a real time morphing from the four selected presets saved on the snap memories. 
 
The four presets are placed on the four cardinal points of the compass. 
 

 
The Morphing interface 

 
� To open the Morphing page, click on the COMPASS button, situated on the toolbar of the 
Sound map. 

 
To create a new morphed sound from those presets: 
 
� Click anywhere on the center of the compass area (four red arrows appear converging to 
the group of presets)  

 
� Hold the left button of your mouse and drag the convergence point until having the good 
sound. The green arrow shows you the starting point of your motion.  
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Create a new sound 

 
�  If you wish, you can save it on a User bank of the CS-80V2 memory. 
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6 USING THE CS-80V2 
 

6.1 SINGLE MODE 
 
When the Multi mode hatch is closed, the CS-80V2 is in Single mode. In this mode, the 8 
polyphonic voices available are set with the same sound. The sound that is used corresponds 
to the settings of the controls apparent in the graphical user interface. 
 

 
Multi mode hatch closed 

 
This mode should be selected if you require the same manner of use as the original CS-80. 
 
 

6.2 TWO LINES OF SYNTHESIS 

 
The original CS-80 has a particular structure. Unlike many synthesizers of that time it used 2 
independent generators of subtractive synthesis, each one with an oscillator, a filter and an 
amplifier. These two lines of synthesis are managed by the central part of the interface in two 
parallel groups of controls. 
 

 
Control of the two lines of synthesis 

 
On each line of synthesis, there is an oscillator that can generate square, triangle, sawtooth, 
and sine signals. The first switch activates the square signal, while the second activates the 
second waveform, which can be either a triangular signal or a sawtooth. 
 

 
Selection of waveform 

 
To select the sine, first validate that the linear ~ slider is lit and then set its volume with this 
slider. 
 
The square and triangle signals are affected by the pulse width settings noted PW. The fader is 
used to choose a pulse width from 50% to 90%. This pulse width can be modified by a low 
frequency oscillator (LFO). The modulation rate is set with the PWM fader and the speed with 
the SPEED fader.  
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PWM Settings 

 
Unlike the original CS-80 LFO where only the sine waveforms were available, the wave can be 
set with the WAVE FORM selector. The waveforms available are sine, saw-up, saw-down, 
square, noise and random. 
 
This LFO can function in three modes chosen on the LFO MODE selector:  

� FREE: all LFOs of each of the polyphonic voices function independently of the others;  
� TRIG: the LFO restarts at the beginning of its waveform each time that the polyphonic 
voice is activated;  

� MONO: only the LFO of the first polyphonic voice is used. 
 
The latter allows us to bring a general effect to all of the voices at the same time, like the 
original CS-80. 
 
It is possible to synchronize the LFO speed with the tempo of the host application with the 
MIDI SYNC button. 
 
The signal from the oscillators then goes through two filters in a series, one high-pass and one 
low-pass. The cut-off frequency and the resonance of each of these filters can be set with the 
green and red HPF and LPF faders (above or below the labels).  
 

 
Setting the filters 

 
By clicking on these labels, it is possible to activate or deactivate a filter in order to save on 
calculation power. 
 
The 24dB button allows us go from a 12 dB filter to a 24 dB filter. The two low-pass and high-
pass filters are simultaneously modified. 
 
The filters are modulated by an envelope where the Initial Level (IL), Attack Level (AL), Attack 
(A), Decay (D) and Release (R) settings function in the following manner: 

� IL represents the start of the envelope relative to the frequency of the filter. The filter 
frequency will be modulated starting with a frequency inferior to the frequency setting. 
The more IL is increased, the lower the starting frequency will be; 

� AL represents the maximum level attained by the envelope; 
� A the attack time, meaning the time that the envelope takes to go from the IL level to 
the AL level; 

� D the decay time, meaning the time that the envelope takes to go from the AL level to 
zero level (no modulation); 

� R the release time, meaning the time that the envelope takes to go from the zero level 
(no modulation) to the IL level. 
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Setting the filter envelope 

 
The output of the filters is controlled by a volume VCF LEVEL before being added to a sine 
wave (>~<). The signal can thus be treated by the output amplifier (VCA) controlled by an 
envelope. The LEVEL control sets the volume at the end of line of the synthesis. 
 
The envelope controlling the VCA is a standard ADSR envelope: 

� A attack time, the time for the volume to go from silent to full volume; 
� D decay time, the time to go from the end of A to S; 
� S sustain level, reached after the decay period; 
� R release time, to come back to 0 once the note has been released. 

 

 
Setting the VCA envelope 

 
Four faders set the action of the velocity and of the pressure of the keys on the frequency of 
the filters and the level of the VCA. The green faders to control the frequency, the gray ones to 
control the volume. 
 

 
Setting the filter frequency and the amplifier volume modulations 

 
Each of the lines of synthesis can be transposed with the 1-FEET-2 selector: an octave below 
(16’), default range (8’), a fifth above (5 1/3’), an octave above (4’), a fifth and an octave 
above (2 1/3’), two octaves above (2’).  
The second line can be tuned with the DETUNE fader, and finally the mixing between the two 
lines is controlled with the MIX fader. 
 

   
Transposition of the lines of synthesis Detuning of the second line Mixing of the two lines 

 
Additional buttons SYNC and LINK increase your sound design options: 

� The SYNC button synchronizes the oscillator of the first line with the oscillator of the 
second. When activated, it is the frequency of the second oscillator that will be audible, 
the frequency of the first being imposed on the second in order to create new 
harmonics. 
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� The LINK button connects the oscillator of the second line toward the filters of the first. 
The filters and amplifier of the second line are not used and therefore deactivated to 
conserve calculation power. 

 
 

6.3 THE MODULATION MATRIX 
 
The original CS-80 possessed no other sources of modulation than those described above. To 
increase the possibilities of synthesis, a new modulation matrix is available. To activate it, 
open the left hatch. (On the original CS-80 this hatch held four mechanical preset selectors.) 
 

   
Closed modulation hatch    Open modulation hatch 

 
There are ten modulation controls available. For each modulation, the source must be selected 
from 12 choices, and the destination in a list of 38 choices, by clicking on the SOURCE and 
DESTINATION displays. The AMOUNT knob sets the rate of modulation. 
 
The sources of modulation are as follows: 

� LFO1  : Low frequency oscillator of the first line 
� LFO2  : Low frequency oscillator of the second line 
� SubOsc : General low frequency oscillator 
� EG Filter1 : Envelope of the filters of the first line 
� EG Amp1 : Envelope of the VCA of the first line 
� EG Filter2 : Envelope of the filters of the second line 
� EG Amp1 : Envelope of the VCA of the second line 
� Velocity : Velocity of the MIDI note 
� AfterT  : Pressure of the MIDI note (Aftertouch) 
� Ribbon : Ribbon controller 
� Wheel  : Modulation wheel 
� FootExp : Expression pedal 
� Off  : No modulation 

 
The modulation destinations are as follows: 

� VCO 1 Freq : Frequency of the oscillator of the first line 
� VCO 1 PW  : Pulse width of the oscillator of the first line 
� Noise level1 : Noise level of the first line 
� Noise level2 : Noise level of the second line 
� VCO 2 Freq : Frequency of the oscillator of the second line 
� VCO 2 PW : Pulse width of the oscillator of the second line 
� HP 1 cutoff : High-pass filter cut-off frequency of the first line 
� HP 1 res : Resonance of the high-pass filter of the first line 
� LP 1 cutoff : Low-pass filter cut-off frequency of the first line 
� LP 1 res : Resonance of the low-pass filter of the first line 
� HP 2 cutoff : High-pass filter cut-off frequency of the second line 
� HP 2 res : Resonance of the high-pass filter of the second line 
� LP 2 cutoff : Low-pass filter cut-off frequency of the second line 
� LP 2 res : Resonance of the low-pass filter of the second line 
� VCA 1 Level : VCA level of the first line 
� VCA 2 Level : VCA level of the second line 
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� SIN 1 Level : Level of the sine of the first line 
� SIN 2 Level : Level of the sine of the second line 
� LFO 1 Speed : Frequency of the LFO of the first line 
� LFO 1 Level : Level of LFO output for the first line 
� LFO 2 Speed : Frequency of the LFO of the second line 
� LFO 2 Level : Level of LFO output for the second line 
� EG VCF1 IL : Starting level for the filter envelope of the first line 
� EG VCF1 AL : Attack level of the filter envelope of the first line 
� EG VCF1 A : Attack time of the filter envelope of the first line 
� EG VCF1 D : Decay time of the filter envelope of the first line 
� EG VCF1 R : Release time of the filter envelope of the first line 
� EG VCF2 IL : Starting level for the filter envelope of the second line 
� EG VCF2 AL : Attack level of the filter envelope of the second line 
� EG VCF2 A : Attack time of the filter envelope of the second line 
� EG VCF2 D : Decay time of the filter envelope of the second line 
� EG VCF2 R : Release time of the filter envelope of the second line 
� EG VCA 1 A : Attack time of the VCA envelope of the first line 
� EG VCA 1 D : Decay time of the VCA envelope of the first line 
� EG VCA 1 S : Sustain level of the VCA envelope of the first line 
� EG VCA 1 R : Release time of the VCA envelope of the first line 
� EG VCA 2 A : Attack time of the VCA envelope of the second line 
� EG VCA 2 D : Decay time of the VCA envelope of the second line 
� EG VCA 2 S : Sustain level of the VCA envelope of the second line 
� EG VCA 2 R : Release time of the VCA envelope of the second line 
� Off  : No destination 

 
To remove a modulation, select OFF in input and output. You could set the level to zero but the 
calculation would still be carried out, thus using CPU power (which is always preferable to 
avoid). 
 
A destination can only accept six sources of modulation. Above this, the modulation is ignored. 
 
 

6.4 THE SUB-OSCILLATOR 
 
The sub-oscillator is a low frequency oscillator (LFO) that affects all of the polyphonic voices. 
The SPEED fader sets the speed and FUNCTION sets the waveform: sine, saw-up, saw-down, 
square, noise and random. 
 

 
Setting the sub-oscillator 

 
The action of this LFO is determined through the VCO, VCF, and VCA faders which sets the 
modulation rate of the oscillator frequency, filter frequency and output level for both lines of 
synthesis. 
 

 
Setting the modulation through aftertouch 

 
The VCO and VCF modulation rate can also be modified through aftertouch with the faders 
under the TOUCH RESPONSE label. The SPEED control also modulates the speed of the sub-
oscillator through aftertouch. 
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6.5 THE KEYBOARD MODULATIONS 
 
The INITIAL fader performs a slight frequency modulation on the oscillators. This modulation is 
a linear ramp that depends at the same time on the fader setting and the velocity.  
 

 
Initial tuning 

 
Fader at the top, there is no modulation; at the bottom, the modulation is set to the 
maximum. 
 

 About the orientation of these faders, the original CS-80 operates in that way, which can be confusing. But we 

chose to reflect the original character of the machine. 

 
The faders under the KEYB. CONTROL label set the key follow rate. The faders under the 
BRILLIANCE label set the key follow of the filters, and those under the LEVEL label set key 
follows for the amplifier: 

� The LOW faders set the key follow slope for the lower part of the keyboard (below C3); 
� The HIGH faders set the slope for the higher part; 
� The slopes can be positive or negative. 

 

 
Key follows 

 
 

6.6 THE RING MODULATOR 
 
The ring modulator is an effect that creates a number of harmonics in the sound through the 
multiplication of the input signal with a sine wave.  
 

 
Setting the ring modulator 

 
Dry and wet mixing is set with the >M< fader. Dry sound is at maximum in the high position. 
The frequency of the multiplying sine is set with the SPEED fader. The lower the fader is 
positioned, the higher the sine frequency. The generated harmonics will then move away from 
harmonics of the treated sound. 
 
Three other faders modulate this effect. These set an envelope applied to the frequency of the 
sine. ATTK gives the time taken for the sine to go from the initial frequency set by SPEED, to 
the frequency set by DEPTH, while DECAY sets the time for the return to the initial frequency. 
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6.7 CHORUS/TREMOLO 
 
Chorus/Tremolo is an effect that allows a variety of effects, from simulation of an ensemble to 
that of a rotary speaker. It is activated with the CHOR switch. 
 

 
Setting chorus/tremolo 

 
The TREM switch takes us from chorus mode to tremolo mode. While the rotary SPEED and 
DEPTH knobs respectively set the speed of rotation and depth of the effect. 
 
 

6.8 STEREO DELAY 
 
Delay is an effect that simulates an echo. It is activated with the DEL switch. 
 

 
Setting Delay 

 
The rotary SPEED, DEPTH and MIX knobs set the time between each echo, the echo decay 
time and finally the output level for the effect. 
 
The MIDI SYNC button is used to obtain echo times as a multiple or sub-multiple of the host 
application tempo. You choose the multiple or sub-multiple with the SPEED knob. 
 
 

6.9 THE PEDALS 
 
The original CS-80 was a synthesizer possessing all of the functions of a real playing surface. A 
number of settings and possibilities of expression and sustain are explained below. 
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Expression pedal 

 
The EXP and WAH buttons, when activated, allow the use of a pedal expression MIDI message 
(0x04) either on the amplification of the volume (expression), or on a sweeping filter (wha-
wha). 
 

 
Portamento and sustain pedal settings 

 
The PORTA fader allows the control of a portamento on notes. This means that for a given 
polyphonic voice, when a new note is activated, the frequency of the VCO will gradually move 
from the frequency of the previous note to the frequency to the currently held note. 
 
When the GLISS switch is at the high position (Off), the passage will be done continuously, at 
the low position (On) it will be done by semi-tone.  
When the play mode of the zone is CSASSIGN (see §6.14), then the portamento transitions 
from note played at least 200 ms before. 
 
It is possible to enable or disable the portamento for each voice (see §6.14). 
 
When the PORTA/GLISS switch is at the low position (On), the choice between the portamento 
(continual variation) and the glissando (variation by semi-tone) is controlled by MIDI 
messages corresponding to the sustain pedal. 
 
The fader above the SUST MODE switch sets the sustain time. When the SUST switch is at the 
top (Off), sustain time is given by the fader setting. When it is set to the bottom (On), sustain 
time depends on the MIDI messages from the sustain pedal. When the pedal is off, there is no 
sustain, when it is on, sustain follows the fader setting. 
 
The two positions of the SUST MODE switch allow standard functioning (switch off, towards the 
top), or a mode where the sustain is interrupted when a new note arrives (switch on, towards 
the bottom). 
 
 

6.10 THE ARPEGGIATOR 
 
The arpeggiator is used to transform a chord into a succession of individual notes. 
 
The SPEED knob sets the speed for the arpeggio; the SYNC button allows us to obtain a 
multiple or sub-multiple tempo of the host application. The PLAY button triggers the 
arpeggiator, which when a note is played activates the notes one after the other, but stops 
when there are no active notes held on the keyboard. The HOLD button memorizes the notes 
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played as long as it is active. The arpeggiator in HOLD mode is stopped through the use of the 
PLAY button. 
 
The MODE selector chooses the arpeggio mode: increasing, decreasing, back and forth, 
random, and in the order that the notes appear. 
 
The OCTAVE selector presents the choice of the number of octaves that the arpeggiator will 
traverse for each cycle. The REPEAT selector is to choose the number of cycles repeated for 
each octave. 
 

 
Arpeggiator settings 

 
 

6.11 THE ORIGINAL PRESET BUTTONS 
 
These buttons, like on the original CS-80 allow the selection of pre-set sounds. These 
selections work like a help system, and as soon as a control is modified, we find the 12 
selection (panel) indicates that the audible sound corresponds to the settings modified by the 
user.  
 

 
Pre-selections 

 
Each pre-selection line corresponds to the control of each line of synthesis. 
 
 

6.12 THE RIBBON 
 
The ribbon works like a pitch wheel when the PITCH button is triggered. The COARSE knob 
sets the upper range of frequency variation. It also responds to the pitch bend MIDI message. 
It should be noted that the original CS-80 had an unusual behavior when using the pitch 
ribbon to control downward pitch shifts. When sliding the pitch range up, the COURSE knob 
limits the amount of pitch shifting, but when bending the frequency down, the range goes all 
the way down to 0 Hz. This is a feature that’s unique to the CS-80, and is faithfully reproduced 
in the CS-80V2, allowing this emulation to create truly unique performances, just like its 
hardware predecessor. 
 

 
The ribbon 

 
 

6.13 GENERAL SETTINGS 
 
Three supplementary settings control the synthesizer’s general brilliance, resonance and 
volume. They each effect polyphonic voices in the same way. 
 



ARTURIA – CS-80V2 – USER’S MANUAL  48 

    
   Brilliance and Resonance  General volume 

 
 

6.14 THE MULTI MODE 

 
When the Multi mode hatch is open, the playing mode is called “multiple”. In this mode, each 
of the eight polyphonic voices available can take a different sound and can be commanded by 
four zones of MIDI control. 
 

 
Opened Multi mode hatch 

 
Under the Multi mode hatch are two identical groups of four lines of settings and a 
supplementary group of four lines. The two first groups set each of the eight voices, while the 
last set the MIDI message control zones. 
 

 
Control zones 

 
The zones allow the independent control of the polyphonic voices. Each zone responds to a 
MIDI channel, which can be assigned to the same or a differing channel. When a note comes 
through the selected channel, it is only taken into account if it is between the limits of the 
KEYB RANGE display. The zone will therefore activate the polyphonic voices associated with it 
depending on the choice in the VOICE MODE display. 
 
To modify the KEYB RANGE limits, double-click on the display and choose the low note with a 
left click and the high note with a right click (or [Shift]+click for Mac). 
There are 6 polyphonic voice modes possible:  
 

� CsAssign: This mode of voice control is identical to the original CS-80. The zone plays 
a voice randomly among the voices that have been affected to it. The portamento (or 
the glissando) is reinitialized when the time between the arrival of this note and the 
release of the previous note exceeds a certain value (in the area of 170 ms). Thus, in 
the case of chords, all of the voices will start their portamento (or glissando) from the 
same note. 

 
� Rotate: The polyphonic voices are used in a rotating assignment. The zone uses the 
next free available voice. When the last voice is reached, then the zone takes the 
newest note played by releasing the first one. 

 
� Reset: The polyphonic voices are played in order by their number. The zone uses the 
first free available voice, beginning with the lowest one. 

 
� ReAssign: When a new polyphonic voice is chosen, the zone uses the voice which has 
just played the same note. 
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� UniLow: Unison with priority to the lowest note. This means that if two notes are 
presented at the same time it is the lowest note that is played. 

 
� UniHigh: Unison with priority to the high note. This means that if two notes are 
presented at the same time it is the highest note that is played. 

 
� UniLast: Unison with priority to the last note played. The newest note is prioritized. 

 
The VOICE ARP button allows you to accept or not accept the use of the arpeggiator on this 
zone, independently of the others. 
The arpeggiator possesses one setting for all zones, but each zone uses the arpeggiator 
independently. This means that each zone can choose to activate the arpeggiator (or not), and 
when a note is present in two zones, the arpeggios remain independent. 
 

 
Control of polyphonic voices 

 
For each voice, you need to choose the zone by clicking on the ZONE display. The OFF position 
allows you to deactivate a particular voice (it is possible to limit the polyphony). 
 
Once the zone has been chosen, the sound (or single) that the voice will use needs to be 
selected. By clicking on the SINGLE PATCH display, we can select one of the singles of the 
current preset or a new single. For a given preset, there can be up to 8 singles (one per voice).  
 
It is important to note that the choice of zones and the choice of sounds are independent. Two 
zones can manage cards using the same sound, and one zone can manage voices with 
different sounds.  
 
The ACTIVE indicator shows the polyphonic voices that are currently active. 
 
Four knobs set (for each voice) the range (+/- two octaves, by semi-tone), fine tune (+/- a 
semi-tone), volume and the position in the stereo field (pan).  
 
In this section it is also possible for each voice to use or not to use the portamento (or 
glissando), the ring modulator or the effects (chorus and delay) with the PORTA, R.MOD or FX 
buttons. 
 
The EDIT button is to edit the sound (or single) assigned to the polyphonic voice. This updates 
the graphical interface controls so that they display the single settings. 
 
The Multi mode possibilities are extremely varied. It is possible to separate the keyboard into 
different zones, each zone with a different sound, to widen an accompaniment sound with the 
stereo image or fine tuning for a large chorused effect. Another example would be to use the 
ring modulator only on one voice in order to limit intermodulation effects, and so forth. 
 
In order to listen to a particular sound, just close the Multi hatch. The sound used is thus the 
sound being currently edited. The closing of the hatch corresponds to solo mode with a voice 
control using the CsAssign mode on the entire of the keyboard. 
 
Certain settings are the same for all voices. This is the case for settings that control the effects 
(chorus, delay, ring modulator), pedals, sustain and portamento. It is also the case for the 
settings controlling the sub-oscillator, the pressure on the keys that affect the sub-oscillator, 
the key follows and finally the general brilliance and resonance of the synthesizer. 
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General settings 

 
The other settings affect each sound independently of the others, setting the different 
parameters of a single voice. 
 

 
Polyphonic Settings 
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7 THE BASICS OF SUBTRACTIVE SYNTHESIS 
 
Of all forms of sound synthesis, subtractive synthesis is one of the oldest and still certainly one 
of the most employed today.  
 
It is this method that was developed toward the end of the 60’s on analog synthesizers like the 
Moogtm, ARPtm, Yamahatm, Buchlatm, Oberheimtm, Sequential Circuitstm (Prophet series), 
Rolandtm, Korgtm (MS and PS series) and many others. This concept of synthesis is still used on 
most current digital synthesizers, complementing sample reading or wave tables, which have 
progressively replaced the analog oscillators of the first synthesizers in the 80’s. The Yamahatm 
CS-80 or even your own CS-80V2 constitutes the best illustration of the enormous possibilities 
of subtractive synthesis. 
 
 

7.1  THE THREE MAIN ELEMENTS 
 

7.1.1 The oscillator (VCO) 

 
The oscillator (Voltage Controlled Oscillator) is the starting module (with the noise module 
which is often classed among the oscillators) for the creation of a sound on an analog system.  
It will generate the initial sound signal. We can think of the oscillator like a violin string that 
once stroked or plucked, vibrates to create its sound. 
The main oscillator settings are: 
 

� The pitch determined by the oscillation frequency. You can set the frequency of the 
oscillator with 2 controllers: first, the FEET selector (or “range” on other synthesizers) 
which determines the fundamental frequency – it is expressed in feet it contains all of 
the harmonics at decreasing volume levels in high frequencies): 16, 8, 4, 2; the 
highest number (16) brings the deepest tone, inversely, the smallest number (2) 
brings the highest tone. – Secondly, the detune setting (detune or fine tune) allows 
you to tune the oscillator more precisely. 

 

 On the CS-80V2, the height settings (FEET) and detune (DETUNE) are found among the real time controllers above 

the keyboard. 

 
� The waveform which determines the harmonic richness of the audio signal. On the 
CS-80V2, 4 waveforms are available: 

 
o The sawtooth presents the richest audio signal of the 4 waveforms (it contains 
all of the harmonics at decreasing volume levels in high frequencies). Its sound 
is ideal for brass sounds, percussive bass sounds or rich accompaniments. 

 

 
Time and spectral representations of a sawtooth signal 
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o The square possesses a more hollow sound that the sawtooth (it only contains 
odd harmonics) but none the less, its rich sound (notably in low frequencies) can 
be used for sub-bass sounds that will come out well in the mix (the square 
oscillator is often set an octave below that of the sawtooth), wood sounds 
(clarinet, if the square signal is a little filtered), etc. 

 

 
Time and spectral representations of a square signal, and with modulated pulse width. 

 
o The triangle can be considered like a highly filtered (and so soft) square signal. 
It is very low in harmonics (odd only) and will be very useful for creating sub 
basses, flute sounds, etc. 

 

 
Time and spectral representations of a triangle signal 

 
o The sinusoid is the purest of all. It is a unique harmonic and produces a much 
“damped” sound. It can be used to reinforce the low frequencies of a bass sound 
or as a frequency modulator in order to create harmonics that don’t exist in the 
original waveforms.  
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Time and spectral representations of a sinusoid signal 

 

� PWM (Pulse Width Modulation) is a setting that allows you to modify the waveform 
cycle (or wave length). This can be done manually with the help of a knob PW or by 
modulation (with an envelope or LFO). This impulse width variation translates to a 
spectrum modification, resembling a waveform change. 

 

 Unlike many other classic analog synthesizers, the CS-80V2 allows you change the impulse width not only for the 

square waveform but also for the triangle. 

This brings a large number of additional sound possibilities to compliment the base signal. 

 

 
The CS-80V2 waveform 

 
� The synchronization of an oscillator with another creates more complex waveforms. 
If for example, you synchronize oscillator2 with oscillator1, oscillator2 will restart a 
new period every time the first oscillator completes a period, even if oscillator2 has not 
completed a complete period (this signifies that it is not tuned to the same tonality.) 
The more you tune oscillator2 upwards, the more you will encounter composite 
waveforms.  

 

 
Synchronization: oscillator2 is synchronized with the first and tuned to with double the tonality. The resulting waveform 

is unique in that it cannot be created by standard synthesis techniques such as layering or filtering. 
 
A ring modulator can be created when an oscillator modulates another oscillator. On the CS-
80V2, you can find the RING MODULATOR module above and to the left of the ribbon 
controller. By lowering the linear >M< slider/lever while increasing SPEED, the sound will 
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become richer in harmonics. The result can quickly become distorted but interesting for 
inharmonic sounds like special effects or bells for example.  
 

 
Ring modulation 

 
The noise module: the noise signal spectrum has all frequencies at an equal volume level, 
often referred to a “white noise”. For this reason, the noise module is used to create different 
noises like the imitation of wind or special effects. White noise is the richest of noises. Pink 
noise is also regularly present on synthesizers. It is less rich in the high frequencies than white 
noise.  
Also note that the audio output of noise can also be used as a modulation signal (especially 
when strongly filtered) to create random cyclic variations. 
On pre-cabled synthesizers, the noise module is either integrated into the oscillator (its audio 
output being placed to compliment the waveform outputs), or within the mixer directing the 
signals towards the filter. On the other hand, on modular synthesizers, it is an independent 
sound source. 
 

7.1.2 The filter or VCF 

 
The audio signal generated by an oscillator (the waveform) is next generally directed to a filter 
module (Voltage Controlled Filter). It is this module that we use to model the sound by 
filtering (by subtraction, which explains the name given to this type of synthesis) the 
harmonics situated around a cut-off frequency. It can be considered like a sophisticated 
equalizer that reduces, depending on the case, the high or low frequencies of a sound. 
 

 
Spectral representation of the filtering action 

 
The removal of undesirable frequencies, with a cut-off frequency is not done suddenly but 
progressively, this, depending on the filtering slope. This filtering slope is expressed in decibels 
per octave (or dB/Oct). The filters used in classic analog synthesizers have 24 dB/Oct or 12 
dB/Oct slopes. 
 

 
The filter settings 
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The CS-80V2 offers 2 types of slope (where the CS-80 had only the 12 dB/Oct slope). 
 
On the CS-80V2, you have access to 3 different types of filtering. Let’s have a look at some of 
their properties: 
 

� The low-pass filter (LPF) deletes high frequencies going from a frequency limit (the 
famous cut-off frequency) and only allows low frequencies through. Depending on the 
setting we will hear the sound becoming more or less “brilliant”, more or less 
“dampened”. This is the type of filtering that you will find more often than not on 
synthesizers that use subtractive synthesis. It can be found on most of the recent 
analog and digital synthesizers 

 

 
The low-pass filter 

 
� The high-pass filter (HPF), unlike the low-pass, eliminates low frequencies and only 
allows high frequencies through. The sound will become “finer”. It is very useful for 
removing redundant low frequencies with a bass sound for example. 

 

 
The high-pass filter 

 
� The band-pass filter (BPF) eliminates frequencies situated on either side of the cut-
off frequency. It is in fact the addition of a low-pass and a high–pass filter. Use it to 
focus on a particular band of frequencies that you wish to emphasize. This will make 
the sound more “pinched”. On the CS-80V2, you obtain this type of filtering by 
combining the actions of a high-pass filter and a low-pass filter as there is technically 
speaking no separate band-pass filter. 
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The band-pass filter 

 
A second setting to compliment the cut-off frequency: the resonance. You will also find it 
called “Emphasis”, or even “Q” – for “Quality of filtering” – on many synthesizers.  
The resonance amplifies frequencies close to the cut-off frequency; the other frequencies 
remaining are either unchanged (before the cut-off frequency) or reduced (after the cut-off 
frequency). 
 
On the CS-80V2, you can increase the rate of resonance through the RES slider. 
 
When you increase the resonance, the filter becomes more selective, the cut-off frequency is 
amplified, and the sound begins to “whistle”. 
 
With a high resonance level, the filter will begin to produce a sound close to a sine waveform. 
At this stage, the use of a key follow is very important as you can create a melody by tuning 
the cut-off frequency of the filter with the frequency of the oscillators. 
 

 
The resonance 

 

7.1.3 The amplifier or VCA  

 
The amplifier (Voltage Controlled Amplifier) receives the audio signal coming from the filter 
(or directly from the oscillator if it is not being filtered) to adjust before the volume is sent to 
the outputs.  
 

 
The CS-80V2 VCA 
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In conclusion, here is a diagram that should help you to understand the composition of a basic 
sound: 
 

 
Audio signal path 

 
 

7.2 OTHER MODULES  
 

7.2.1 The keyboard 

 
If we stop here, the sound that you will obtain will be uniform, without life and without an end. 
The oscillator delivers a sound signal (the audio output of a waveform) of a fixed pitch in a 
continuous manner. In the diagram above, the only way to stop this quickly disagreeable 
sound is to lower the filter cut-off frequency so that it becomes more and more damp until it 
finally disappears; or simpler yet, lower the volume of the amplifier.  
 
To start and stop the sound, and at the tone that we require, we use a keyboard that is 
connected to the oscillator. This will play the sound as soon as a key is pressed, and mute it 
when released. Of course, this connection is made through MIDI (it replaces the “gate” type of 
connections on analog synthesizers, which triggers the note when a key is pressed and stop it 
when released). On analog synthesizers, the key provides a gate which is often used to open 
and close the volume of the amplifier. The key position provides a control voltage that tells the 
oscillator what pitch level to play when the gate opens. 
 

7.2.2 The envelope generator 

 
The envelope generator, connected to the amplifier, is used to sculpt the volume of the sound 
when we press a key on the keyboard and ends after the note is released. 
 
The most common modules developed use 4 settings that we can vary: 

� The Attack is the time that the sound will take to reach its maximum volume once we 
have pressed a key on the keyboard; 

� The Decay (fall) is the time that the sound will take to diminish when a note is 
pressed; 

� The Sustain (hold) is the maximum volume level that the sound will reach when a key 
is pressed; 

� The Release is the time that the sound will take to diminish once the key has been 
released. 
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ADSR envelope 

 
On the VCF of the CS-80V2, the envelopes include 2 additional settings: 

� The initial level (IL) is the start level of the envelope relative to the frequency of the 
filter. The filter frequency will be modulated starting with a frequency inferior to the 
frequency setting.  

� The attack level (AL) is the maximum level of the filter envelope. 
 

 
The CS-80V2 ADSR envelope 

 

7.2.3 The low frequency oscillator 

 
The LFO (Low Frequency Oscillator – or SUB OSCILLATOR on the CS-80V2) possesses more or 
less the same characteristics of the classic oscillator but it only produces frequencies lower 
than 20 Hz. In other words, you won’t hear the pitch of its sound, but rather use it as a cyclic 
modulation on the setting to which it is connected. 
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Low frequency oscillator modulation 

 
For example:  
 

� If the LFO sinusoid waveform modulates the volume of an amplifier, the sound will 
increase in volume then disappear in a varying manner following the speed (the 
frequency) of this LFO. This will produce a tremolo effect. 

 
� An LFO sinusoid waveform modulating the frequency of an oscillator would produce a 

vibrato effect. The frequency of this oscillator will thus be modulated up and down. 
 

� With an LFO sinusoid waveform modulating the cut-off frequency of a slightly resonant 
band-pass filter, you will obtain a wah wah effect. 

 

 
The LFO section of the CS-80V2 

 
Now to finish, here is the diagram of a complete synthesis voice on the CS-80V2 containing: 

� 1 oscillator (VCO) 
� 1 noise module 
� 1 mixer (mixing of the 2 VCO and the noise module towards the low-pass and high-
pass filters) 

� 2 filters (VCF) high-pass and low-pass 
� 1 amplifier (VCA) 
� 2 envelopes (one for the filters and the other for the VCA) 
� 1 LFO 
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A complete CS-80 synthesis voice 

 
 



ARTURIA – CS-80V2 – USER’S MANUAL  61 

8 A FEW ELEMENTS OF SOUND DESIGN 

 
Here is a series of examples designed to guide you through the creation of various sounds as 
well as a vintage analog styled note sequence. They progress in order of difficulty going from 
the easiest to the most difficult and are organized into 3 parts: 
 
� The first part will help you to grasp subtractive sound synthesis. You will start with the 
most basic patch (patch a VCO oscillator through a filter and a VCA amp output), to finish 
by touching on the programming of a more rich sound (several VCO sources, VCF filters, 
VCA envelopes, etc.); 

 
� The second will help you to use the Multi mode and the arpeggiator; 
 
� The third will give you tips on creative use of key follows, and creating a stereo sound 
without the use of additional chorus and delay effects. 

 
 

8.1 SUBTRACTIVE SOUND SYNTHESIS 
 

8.1.1 A basic sound 

 
To begin we will see how to program a basic sound. As we saw in Quick Start chapter 3, the 
CS-80V2 uses two identical and independent lines of synthesis. We will only use the first (the 
one above) for this example. It will be simply composed of: 

� an oscillator 
� a low-pass filter 
� an output VCA 
� the envelope corresponding to the output VCA. 

 
� Choose the preset saw in the Templates bank, sub-bank Waveforms. This sound uses a 
sawtooth waveform, the high-pass filter is closed (but not deactivated), while the low-pass 
is completely open. The amplifier envelope has a minimum attack time (A) as well as a 
short release time (R). This minimalist configuration will let you easily perform some simple 
experiments with this basic sound. 

 
� Start by progressively lowering the cut-off frequency of the low-pass filter. The sound gets 
softer and softer.  

 
Decrease the frequency of the low-pass filter 

 
� Increase the frequency of the high-pass filter. You will hear the sound lose its low 
frequencies; to clearly hear this effect, make sure not to set the cut-off frequency of the 
low-pass filter too low as the sound will be too soft. 

 
� Change the range of the oscillator from 8” to 16” with the FEET 1 fader. 
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Change the range of the oscillator 

 
� Now increase the release time (R) of the VCA1 to the value 1000 ms so that the sound 
persists after the release of the keys. Be sure to set the level of the general sustain fader 
(S) to 0, so that the changes on the release time can be effective. 

 

 
Increase the VCA release time 

 
Now you can add all the parameters you want, like changing the oscillator waveform, activate 
the sine waveform, change the filter attack. 
 

8.1.2 The modulation matrix 

 
We will discover one of the many additions to the CS-80V: the modulation matrix.  
 
To begin, open the matrix hatch by clicking on its bottom-left corner: 
 

 
Open the Modulation Matrix 

 
Now set the LFO1 as a source in the first modulation source area, and the VCO 1 Freq as 
destination. 
The LFO1 speed can be changed with the speed button: 
 

 
Set the LFO Speed 

 
The VCO1 frequency is now modulated by the LFO1. It creates a kind of detune, if you set the 
amount to the maximum, the sound becomes much more pronounced. 
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Matrix amount 

 
For the second modulation, we will now modulate the filter by the sub-oscillator. 
 
For that, select the SubOsc as source and the HP1 cut as destination. Set the amount you 
prefer and listen to the sound. You can choose the threshold of the filter by lowering the filter 
frequency. 
 
And to finish this part, connect the modulation Wheel to the LFO2 speed, and the LFO2 to the 
LP1 cut: 
 

 
 
Your sound is now modulated by different parameters, adding unique complexity.  
 
Try different matrix settings to see how the CS-80V2 can become an effective solution to 
design your own sounds. 
 

8.1.3 Use of real time controllers 

 
As we have previously seen, the use of real time controllers is one of the strong points of the 
CS-80V2. They will allow you to apply a large variety of simple and quick modulations to the 
sound all while playing the keyboard. 
  

Velocity and aftertouch 
These 2 controllers are directly linked to the playing on the keyboard: 

� Velocity controls the cutoff frequency (BRILL) and the VCA volume.  
� Aftertouch controls the speed of the vibrato modulation, and the VCA volume.  

 
This was the configuration of the original CS-80. But you will be able to go further thanks to 
the modulation matrix, as these controls are among the sources of modulation. 
 
Aftertouch can be employed to accentuate one of the 2 voices of synthesis: apply aftertouch 
on the VCA volume. When you press harder on a note on the keyboard, the volume of voice 2 
will progressively appear. This will create a morphing effect between these 2 voices. 
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Apply aftertouch on the VCA volume 

 

The ring modulator 

The ring modulator is essentially used to add a variety of harmonics to a sound. 
Let’s use the example of the sound from a bell:  
 
� Start by activating the ring mode by clicking in the >M< logo: 
 

 
Activate the ring modulator 

 
� Increase the release time (R) on the envelope of VCA1 towards 440 ms. 
 
The SPEED setting of the ring modulator allows you to very quickly increase the number of 
secondary harmonics in order to create a bell sound (around 150 Hz, barely the halfway mark 
for the knob), or a simple beating identical to a tremolo (around 2 Hz).  
 
� To get a bell sound, the oscillation frequency must be high, set this knob around 2,000 Hz. 
 

 
The SPEED setting  

 
� Lightly lower the >M< lever (around 0.20) to mix the volume of the raw sound with the 
one coming from the ring modulator. 

 

 
Using the ring modulator for a bell sound 

 
� If you wish, you can control the speed of the ring modulator in a progressive manner with 
an attack envelope (A) or even through an external MIDI controller. This helps you to 
easily create special effects. 

 
 

8.2 MULTI MODE 

 
The Multi mode allows the creation of a combination of different sounds (up to 8) spread 
across keyboard zones (up to 4) within an individual preset. They bring very different results 
which directly influence how a sound or sequence is played. 
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8.2.1 Four different sounds on the keyboard 

 
� Choose the preset Multi_Sequence in the bank Templates, sub-bank Sequences_arp. On 
launch the 8 voices are assigned to the voice1 (C0 to C8). Each of the 4 zones has a 
different single sonority (the singles named 1, 2, 3 and 4). These singles can be detuned, 
assigned to a pan position and mixed. In this example, voices 1 to 8 are the same and 
have the same settings such as Pan and volume.  

 
� Change the pan position of the first voice. Place the sound to the left of stereo space: turn 
the PAN knob fully to the left, value 1.00L. 

 
� Also detune it by lightly turning the DET knob to the left, value of 0.99. 
 
� Now change the pan position of the fifth voice fully to the right, value 1.00R. 
 
� Detune the third: set the DET knob to a value of 1.01. 
 
� Use pan to position this single lightly to the right, value 0.78R. 
 
� Detune the fourth: put the DET knob to a value of 1.00. 
 
� Place these 4 voices to unison play mode by selecting the UniLast function in the play mode 
menu of the edit zone.  

 
� Now change the second and the seventh voice to zone 2 with single patch 2. 
 
� Change the voice mode of the second voice to Unilow. 
 
� You can now edit the second single patch by clicking on the EDIT red button. 
 
� Set the transpose of the seventh voice to -12. 
 
� Now set the different level of each voice to get your sound. 
 
 
By performing these first settings, you have modified the Multi_Sequence preset. You can now 
save it in your own bank. 
 

 
The completed preset 

 
� If you wish to use this configuration with a MIDI sequencer playing each single on a 
different MIDI channel, choose a channel for each zone. 

 

 Don’t forget that the notes played outside the limits of each of the 4 zones will not sound. 

 
 

8.2.2 A composite sonority in unison mode 

 
Now let’s see a different use of the unison mode: layering several singles on the same note 
(remember you can go as far as 8 simultaneous voices). 
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� Choose the preset Multi_Sequence in the bank Templates, sub-bank Sequences_arp. This 
preset contains 8 different singles but they are played successively to each note played. 
They are all assigned to zone 1 which covers the whole keyboard. 

 
� Deactivate the VOICE ARP next to the voice mode: 
 

 
Deactivate the arpeggiator 

 
� Begin by placing zone1 to UniLast unison mode. All of the singles should be played by the 
same note.  

 

 
Placing zone1 to UniLast unison mode 

 
� Detune them with the DET knobs. The global sound will achieve more complexity. 
 
� Also change the pan position of each of the singles in order to form a very large stereo 
sound. 

 
� Singles can be sent to delay and chorus effects using the FX button. The ring modulator will 
not be used for this sound. Deactivate the R.MOD button on all of the singles. 

 
� It is also possible to change the pitch of certain singles by detuning them by an octave or a 
fifth below. 

 
You will thus obtain a rich and powerful lead sound. 
 

 
Unison mode settings 

 

8.2.3 Introduction of the arpeggiator in a Multi preset 

 
Now let’s program a Multi preset using the arpeggiator on one of the 4 zones. 
 
Take the preset 2Parts_Splits, from the Templates bank, Splits sub-bank. 
2 split zones on the keyboard are already in place: 

� A single bass sound on zone 1, from C0 to B2, which will be played in ARP mode; 
� A lead accompaniment single on zone 2, from C3 to C8. 

 
The arpeggiator will act on zone1. 
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� Click on the arpeggiator PLAY button and set a speed next to 160 ms, or Tempo*4 if you 
have clicked the MIDI sync button. 

 

 
The arpeggiator PLAY button 

 
� Play a chord between C0 and B2, the notes one after the other on the order that you 
placed them. 

 
� It is possible to change the playing order by clicking on the MODE slider. 
 

 
The linear MODE slider 

 
� If you wish, you can hold the chord by clicking on the HOLD switch.  
 
� To remove one or several notes, click again on the HOLD button and play the note to be 
removed. 

 
It is now possible to simultaneously play or record a bass part on the first octave of your 
keyboard, accompaniments on the next 2 octaves, while having the arpeggio on the last. 
 

 
The arpeggiator settings 

 
 

8.3 OTHER SIDES OF THE CS-80V2 
 
When we move away from the conventional methods of play, the CS-80V2 offers programming 
options that help you to go further. 
 
Here are a few examples… 
 
 

8.3.1 A step sequencer 

 
By conjointly using the arpeggiator and Multi mode settings, it is possible to obtain an 8-note 
step sequencer.  
 
� Load the preset Multi_Sequence, from the Templates bank, Sequences_arp sub-bank: the 
8 voices are on the same zone (the first) and the same single 1. The VOICE ARP button is 
active on the 8 voices. 

 
� Start by clicking on the PLAY button on the arpeggiator and play one note on the keyboard. 
You can hear that all of the voices play one after the other (zone 1 is set to Rotate mode) 
with the same height. 
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� When the arpeggiator is playing, you can set the decay time (D) on the VCA1 and 2 
amplitude envelopes. The shorter the time, the more percussive the sound. Of course the 
effect produced will only be heard correctly if the sustain level (S) is 0. 

 
� So that the arpeggio plays alone, click on the arpeggiator HOLD switch. 
 
� Set the height of each of the 8 notes by turning the HOLD transposition knob among the 
single voice settings. When you turn to the right, the height of the note increases by semi-
tone, if you turn to the left, the height decreases by a semi-tone. Choose the values that 
suit you to make an 8-note melody. 

 
� It is also possible to change the note order by moving the MODE slider of the arpeggiator. 
 
� To obtain a better distribution of the notes in stereo, you can set the stereo position of 
each voice to the left and to the right through the use of the pan pots. 

 
� To create silence on one of the 8 voices, lower the VOL knob for the selected single. 
 

 By choosing the UniLast mode for zone1 you will get a series of notes. If you wish to transpose the note, make sure 
that the arpeggiator HOLD button is deactivated. 

 

8.3.2 Stereo sound without the effects 

 
If you use a preset with one of the 3 unison modes (High, Low, Last), it is possible to make the 
sound fatter and heavier without using a chorus effect. 
Remember that in this mode, all of the voices assigned to that zone play at the same time 
when we press a note. 
 
� Start by slightly detuning all of the voices used in this sound. 
 
� Separate the stereo position of each voice. 
 
You will get a sonority that is naturally large and nearly identical to what can come from a 
chorus effect. It should be noted that the more voices you use, the richer the sound. 
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9 USING THE CS-80V2 IN DIFFERENT MODES 
 

9.1 STANDALONE 
 
The CS-80V2 application can be used as an instrument independent of a sequencer (stand 
alone mode). It allows you to open one or several instruments, and to play with a master MIDI 
keyboard. 
 
 

9.1.1 Launching the application 

 
To launch the CS-80V2 application from Windows, go to Start > Arturia > CS-80V2 and choose 
CS-80V2. 
On Mac OS X, open the Finder > Applications > Arturia CS-80V2 folder and double click on the 
CS-80V2 application icon. 
 
You can also double click on a saved document in order to open the corresponding 
configuration in the CS-80V2 application.  
 

9.1.2 Setting preferences 

 
The preferences window allows you to set the global preferences in the CS-80V2 application. 
These settings are automatically saved. 
 
To display the preferences window go to the File > Preferences menu on Windows, and CS-
80V2 > Preferences on Mac OS X. 
 

 
The configuration window under Windows 
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The configuration window under Mac OS X 

 
� Audio protocol (Windows only): select the audio protocol that you want to use. If you 
have ASIO drivers for your sound card, it is highly recommended that you use the 
ASIO protocol; the ASIO drivers propose a higher performance rate in relation to the 
DirectX driver. 

� Audio driver: select the driver corresponding to the sound card that you want to use.  
� Sample rate: choose a sample frequency among those offered by your sound card.  
� Audio latency: you can set the optimal audio latency in relation to the performance of 
your sound card and your system. However, a latency set too low may cause 
occasional jumps in the sound. 

� Knob control type: choose the instrument knob control mode.  
 

 If you haven’t any ASIO driver for your sound card, the ASIO4ALL generic driver should do the job, and is freely 

available to download at this address: http://www.asio4all.com/ 

 

9.1.3 The control bar 

 
Each instrument has a control bar setting the routing of MIDI events as input, and sound as 
output. 
 

 
The Windows control bar 

 

 
The Macintosh control bar 

 

Configuration of MIDI routing 

The first section of the tool bar is for selecting the MIDI input that will be applied to the 
instrument.  
Choose the MIDI port you are using to control the instrument, and the channel that you wish 
to use. You can choose to respond to one or all of the channels of this MIDI port by selecting 
All or a selected MIDI Channel number in the MIDI channel choice. 
 

Configuration of the keyboard zone 
The keyboard zone allows you to use only a section of the keyboard to control the instrument. 
In this manner, you can play several instruments on the same keyboard, each instrument 
responding to a different zone. 
To activate this function, check the ‘range’ option in the tool bar. You can then limit the 
keyboard zone by setting the lowest and highest note to be applied to this instrument. 
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Configuration of the octave 

The octave allows you to transpose the notes of your keyboard by one or several octaves. This 
function is useful if your keyboard doesn’t cover the octave in which you wish to play or if you 
have activated the keyboard zone option. 
 

Configuration of the audio input and output 
The two last parts of the toolbar are used to select the audio channel on which you wish to 
play this instrument, and the one that will provide audio input. 
If the selected soundcard has several audio outputs, and respectively audio inputs, you will 
find those available in this list. Just choose the pair of outputs or inputs that you desire. 
 

9.1.4 Information on the level of processor use 

 
The processor usage gauge allows you to monitor the level of processor load in real time:  

� On Windows, this gauge is directly visible in the instrument tool bar.  
� On Mac OS, you can display it by choosing Window > Cpu in the application menu, or 
from the shortcut + L. 

 

 This information only comprises the processor load corresponding to the sound synthesis; it is therefore 

subordinate to the global system load. 

 

9.1.5 Panic 

If notes remain active without reason, it is possible to send a MIDI message to the instruments 
in order to cut all of the notes that won’t stop when released: 

� On Windows, click on the  icon in the instrument tool bar. 
� On Mac OS, this command is found under Help > Panic, or through the shortcut 

+ +P. 
 

9.1.6 Saving an instrument 

 
Saving allows you to save the state of an instrument, that is to say its sound settings, but also 
the audio and MIDI configuration. 
 
To save a configuration, just select File > Save or File > Save as… to save the configuration 
under a new name. 
 

 Saving a configuration in the CS-80V2 application saves the sound settings of the instrument, this has nothing to 

do with the saving of the presets of the instrument itself (see section 4.1.3 Saving a user preset). The saving in the 

application does not imply the saving of the current preset. 

 
 

9.2 USING YOUR PLUG-IN IN A HOST 
 

9.2.1 MIDI connection 

 
Before using your plug-in with a host, please check that the MIDI connection between your 
computer and the MIDI device is operational. It can be verified by playing in standalone mode 
with the appropriate direct MIDI routing to the application.  
 

 There are alternative ways to check the MIDI connection:  

⇒ On Windows, the MidiOx software can be used to see the MIDI Data traveling on your devices.  
⇒ On Mac OS, the MIDI Monitor is the common solution. 
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9.2.2 Saving a preset 

 
When the session is recorded, the state of the CS-80V2 is recorded as is, even if the 
programming does not correspond to any preset. For example, if you were working on preset 
P1 on which you had modified the parameters (without having saved them under the name 
P2), the next time the song is opened, the CS-80V2 will load preset P1 with the modifications. 
 
The drop down menu offered by the VST sequencer to save plug-in settings can of course be 
used with the CS-80V2. Nevertheless, it is strongly recommended that you use the internal 
CS-80V2 menu: the presets saved in this manner can be used in any other mode (standalone 
or other sequencer), and can be exported as a unique file. 
 

9.2.3 Automation 

 
Automation works with the CS-80V2 as like any other VST plug-in (refer to the VST sequencer 
documentation for more information on the automation of plug-ins). Preset changes cannot be 
automated. 
 
 

9.3 VST 
 

9.3.1 Cubase 

 

Check plug-in setup 

Opening the CS-80V2 VST as a plug-in is accomplished like any other VST plug-in; please 
consult the user manual of the host sequencer for more information. For Cubase 5, open the 
menu Devices > VST Instruments, and choose CS-80V2 in the rack: 
 

  
Opening the CS-80V2 in Cubase 5, under Mac OS X and Windows 

 
So that the CS-80V2 can play from a MIDI track, you must choose a MIDI track and select the 
CS-80V2 as the MIDI output for this track using the menu in Cubase which is used for this: 
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Connection of a MIDI track to the CS-80V2 

 
The events played on a MIDI keyboard are then transmitted by your sequencer to the CS-
80V2. It is of course possible to record these MIDI events, and use all of the sequencers MIDI 
editing possibilities. 
 
You can also create an instance of the CS-80V2 instrument by creating an Instrument Track in 
Cubase. Simply right/command click in the track listing of the project and select Add 
Instrument Track. The Instrument selection dialog will appear where you can select the CS-
80V2. 
 

 
Create Instrument track 

 
Once created, the routing of the default MIDI input to the CS-80V2 is set for that track. 
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All MIDI inputs drive the CS-80V2 

 

Opening the instrument 

To open the CS-80V2, please click on the little keyboard logo located below the instrument 
track output, as shown hereunder: 
 

 
Open the VST Instrument 

 

9.3.2 Ableton Live 

 

Check plug-in setup 
Opening the CS-80V2 plug-in is done like any other plug-in, please consult the user manual of 
the host sequencer for more information.  
 
In Live > Preferences > File Folder, please check that the Audio Unit and VST boxes are active 
as display below: 
 

 
Set the VST folder for Ableton Live 
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Insert an Instrument Track 
To insert an instrument track, open the left sided folder. All your plug-in devices are listed as 
below. Then, double click on your Instrument will create a MIDI track which include your CS-
80V2. 
 

 
List of the plug-in devices 

 

Opening the instrument 
To open your instrument, display the Live detail view by double clicking on the MIDI track, or 
press [Cmd]+[Alt]+L on Mac OS, or [AltGr]+L on Windows. The detail view show you the 
device and an assignable X-Y control. 
 

 
Live detail view 

 
The first button is a On/Off Switch for the VST, the second one is to define the parameters of 
the instrument, and the third is to open the CS-80V2 window. 
 

 
The three buttons 

 

 Ableton Live is able to use your instrument in VST mode and Audio Unit mode if you work on a Macintosh. The text 

above works for both. 

 

9.3.3 Sonar 

 

Insert an Instrument Track 
To insert a track in your project, click on Insert > Virtual synths, then choose the CS-80V2. 
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Inserting a virtual synth track 

 
The program will ask you for Track option, press OK or make your own configurations. 
 

Opening the instrument 
To open your Virtual CS-80V2, please double click on the MIDI logo on your MIDI track as 
below: 
 

 
Open the virtual instrument 

 
 

9.4 AUDIO UNIT 
 

9.4.1 Logic Studio 

 

Check plug-in setup 

Opening the CS-80V2 plug-in is done like any other plug-in, please consult the user manual of 
the host sequencer for more information.  
In order to check the good setup of your Audio Unit, go to Logic > Preferences > Audio Units 
Manager as below: 
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Go to Audio Unit Manager 

 
The Audio Unit Manager gives information about all the plug-ins detected by Logic. Please 
scroll to the CS-80V2 and check that the Logic Box is ticked: 
 

 
Audio Unit list 

 
You are now ready to create a new instrument track. 
 

Insert an Instrument Track 
To insert an Audio Unit track please proceed that way: 
 
� Click on the ‘+’ logo next to Global Tracks as below : 
 

 
Create an instrument track 

 
� On the popup window, select Software Instrument and press Create. 
 
� Your Logic project now contains an empty MIDI track. To assign a CS-80V2 as input, click 
on the grey field above the track output (Out 1-2): 
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Input field 

 
� Select AU Instruments > Arturia > CS-80V2 > Stereo: 
 

 
Select the CS-80V2 

 

Opening the instrument 

In order to open the CS-80V2 you must click on the previous grey field now replaced by the 
CS-80V2: 

 
Open the Instrument 

 
You setup is now functional and your CS80 is ready to be played. 
 
 

9.4.2 Digital Performer 

 

Insert an Instrument Track 

Opening the CS-80V2 plug-in is done like any other plug-in, please consult your host 
sequencer user’s manual for further information.  
To insert an instrument track, click on Project > Add Track > Instrument Track then choose 
the CS-80V2. 
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Insert an instrument track 

 

Connection to a MIDI track 

So that the CS-80V2 can play the information coming from a MIDI track, you must choose a 
MIDI track and select the CS-80V2 as the MIDI output for this track using the adequate menu 
in Digital Performer: 
 

 
Connecting a MIDI track to the CS-80V2 

 
The events played on a MIDI keyboard are then transmitted by your Digital Performer to the 
CS-80V2. It is of course possible to record these MIDI events, and use all of the Digital 
Performer MIDI editing possibilities. 
 

Opening the instrument 
To open your virtual instrument double click the field you have just filled (available in the 
Mixing board): 
 

 
Open the CS-80V2 

 
 

9.5 PRO TOOLS (RTAS) 
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9.5.1 Installation 

 
During the initial installation, select Install as a RTAS/HTDM plug-in. 
 
Then, when you are asked, indicate the folder in which the other RTAS and HTDM plug-ins are 
placed. By default, the path is: 

� for Mac OS X: /Library/Application Support/Digidesign/Plug-Ins 
� for Windows: C:\Program Files\Digidesign\DAE\Plug-Ins 
 

Whether your system can use the HTDM plug-ins or not (see the next section), the installation 
is the same. 
 

9.5.2 The RTAS and HTDM standards 

 
The CS-80V2 can run with the Digidesign audio engine (DAE) in two ways: 
 

� As a RTAS plug-in (Real Time Audio Suite)  
All of the Pro Tools systems are compatible with this standard: the audio treatment is 
realized entirely by the central unit, and does not require any specific extension card 
(TDM system type). On the TDM systems, the RTAS plug-ins can only be loaded in an 
audio track before the TDM plug-ins, and only on an Aux Input or a Master Fader. 

 
� As a HTDM plug-in (Host Time Division Multiplexing)  
Only the TDM systems (with at least one extension card) under Mac OS Classic and X 
can use these plug-ins (refer to Digidesign for the future HTDM compatibility with 
Windows). The latter works exactly like TDM plug-ins (no limitations in the insertion 
positions, etc…), with the difference that in this case, the heart of the treatment is 
realized by the central unit, not by the extension cards. The advantage of this standard 
is the subtlety of TDM, and this with lesser load on the cards DSP. 

 
Recap on the compatibilities:  
 

 Mac OS X Windows 2000/XP/Vista/7 

TDM System 
RTAS and HTDM 

(stereo in/stereo out) 
RTAS 

(stereo in/stereo out) 
Other Systems 

(Pro Tools LE, Free) 
RTAS (mono in/stereo out and 

stereo in/stereo out) 
RTAS (mono in/stereo out and 

stereo in/stereo out) 
 

9.5.3 Insert instrument track 

 
Access to the CS-80V2 plug-in is done like any other plug-in, through an audio track insert, for 
instance: 
 
� To create a new instrument track, click on Track > New track > Instrument track (set it up 
as a stereo track): 

 

 
Add an Instrument track 
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� Insert the CS-80V2: click on Window > Mix View, and the window shows the empty 
instrument track with its Inserts field. Click on an empty Insert field and select 
multichannel plug-in > Instrument > CS-80V2 (stereo). 

 

 
Insert the CS80V2 

 
� To open you instrument click on the same Insert area: 

 
Open the RTAS plug-in 

 
Protools is now ready to play the CS-80V2. 
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10 APPENDICES 
 
 

10.1 GENERAL PARAMETERS FOR ALL POLYPHONIC VOICES 
 
atavcf Pressure action setting (aftertouch) on the amplitude of the sub-oscillator 

action on the VCF 
atavco Pressure action setting (aftertouch) on the amplitude of the sub-oscillator 

action on the VCO 
atinit Velocity action setting on the glissando for the start of the note 
atspeed Pressure action setting (aftertouch) on the frequency of the sub-oscillator 
bend Tuning wheel (pitch bend) 
brill General synthesizer brilliance 
depcho Chorus depth 
depdel Delay depth 
drydel Level of mixing of the part treated by the delay 
exp Expression pedal 
kbbrhi Key follow setting for the superior section, on the on the filter cut-off 

frequency 
kbbrlo Key follow setting for the inferior section, on the on the filter cut-off 

frequency 
kblvhi Setting for the key follow for the superior section, on the VCA volume 
kblvlo Setting for the key follow for the inferior section, on the VCA volume 
mod Modulation wheel 
panv1 Pan position of track1 
panv2 Pan position of track2 
panv3 Pan position of track3 
panv4 Pan position of track4 
panv5 Pan position of track5 
panv6 Pan position of track6 
panv7 Pan position of track7 
panv8 Pan position of track8 
portam Portamento time setting 
reson General synthesizer resonance 
ringAt Ring modulator attack time 
ringDc Ring modulator decay time 
ringDp Ring modulator modulation depth 
ringMo Amplitude of mixing of the part treated by the ring modulator 
ringSp Sinusoid frequency of the ring modulator 
specho Chorus speed 
spedel Delay speed 
subAvcf Modulation amplitude of the sub-oscillator on the vcf’s 
subAvca Modulation amplitude of the sub-oscillator on the vca’s 
subAvco Modulation amplitude of the sub-oscillator on the vco’s 
subfrq Sub-oscillator frequency 
tunv1 Tuning of track1 
tunv2 Tuning of track2 
tunv3 Tuning of track3 
tunv4 Tuning of track4 
tunv5 Tuning of track5 
tunv6 Tuning of track6 
tunv7 Tuning of track7 
tunv8 Tuning of track8 
volume General synthesizer volume 
volv1 Volume of track1 
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volv2 Volume of track2 
volv3 Volume of track3 
volv4 Volume of track4 
volv5 Volume of track5 
volv6 Volume of track6 
volv7 Volume of track7 
volv8 Volume of track8 
 

10.2 PARAMETERS APPLIED TO A PARTICULAR TONE 
 
Each setting begins with Sx, with x being the tone number (single) from 1 to 8, so the 
following list is related to single 1: 
 
S1AfBr1 Brilliance of line 1, controlled by the pressure (aftertouch) 
S1AfLe1 Volume of line 1, controlled by the pressure (aftertouch) 
S1AfBr2 Brilliance of line 2, controlled by the pressure (aftertouch) 
S1AfLe2 Volume of line 2, controlled by the pressure (aftertouch) 
S1Detun Detuning of line 2 in relation to line 1 
S1ev1Al Attack level for the envelope of the filters on line 1 
S1ev1At Attack time for the envelope of the filters on line 1 
S1ev1Dc Decay time envelope of the filters on line 1 
S1ev1In Initial level for the envelope of the filters on line 1 
S1ev1Re Release time for the envelope of the filters on line 1 
S1ev2At Attack time for the envelope of the VCA on line 1 
S1ev2Dc Decay time for the envelope of the VCA on line 1 
S1ev2Re Release time for the envelope of the VCA on line 1 
S1ev2Su Sustain time for the envelope of the VCA on line 1 
S1ev3Al Attack level for the envelope of the filters on line 2 
S1ev3At Attack time for the envelope of the filters on line 2 
S1ev3In Initial level for the envelope of the filters on line 2 
S1ev3Dc Decay time for the envelope of the filters on line 2 
S1ev3Re Release time for the envelope of the filters on line 2 
S1ev4At Attack time for the envelope of the VCA on line 2 
S1ev4Dc Decay time for the envelope of the VCA on line 2 
S1ev4Re Release time for the envelope of the VCA on line 2 
S1ev4Su Sustain level for the envelope of the VCA on line 2 
S1FrHi1 Line 1 high-pass filter cut-off frequency 
S1FrLo1 Line 1 low-pass filter cut-off frequency 
S1FrHi2 Line 2 high-pass filter cut-off frequency 
S1FrLo2 Line 2 low-pass filter cut-off frequency 
S1InBr1 Brilliance of line 1, controlled by the velocity 
S1InLe1 Volume of line 1, controlled by the velocity 
S1InBr2 Brilliance of line 2, controlled by the velocity 
S1InLe2 Volume of line 2, controlled by the velocity 
S1Lev1 Line 1 VCA level 
S1Lev2 Line 2 VCA level 
S1LevF1 Line 1 filter output level 
S1LevF2 Line 2 filter output level 
S1Lf1Sp Line 1 LFO speed 
S1Lf1Pw Line 1 impulse width modulation amplitude 
S1Lf2Sp Line 2 LFO speed 
S1Lf2Pw Line 2 impulse width modulation amplitude 
S1Mixe Mixing of line 1 and line 2 
S1M01Am Modulation amplitude for line 1 of the matrix 
S1M02Am Modulation amplitude for line 2 of the matrix 
S1M03Am Modulation amplitude for line 3 of the matrix 
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S1M04Am Modulation amplitude for line 4 of the matrix 
S1M05Am Modulation amplitude for line 5 of the matrix 
S1M06Am Modulation amplitude for line 6 of the matrix 
S1M07Am Modulation amplitude for line 7 of the matrix 
S1M08Am Modulation amplitude for line 8 of the matrix 
S1M09Am Modulation amplitude for line 9 of the matrix 
S1M10Am Modulation amplitude for line 10 of the matrix 
S1o1noi Oscillator 1 noise level 
S1o1sin Oscillator 1 sinusoid level 
S1o1wid Oscillator 1 impulse width 
S1o2noi Oscillator 2 noise level 
S1o2sin Oscillator 2 sinusoid level 
S1o2wid Oscillator 2 impulse width 
S1ReHi1 Resonance of the line 1 high-pass filter 
S1ReLo1 Resonance of the line 1 low-pass filter 1 
S1ReHi2 Resonance of the line 2 high-pass filter 
S1ReLo2 Resonance of the line 2 low-pass filter 
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CS-80V2 

END USER LICENSE AGREEMENT 
 
 
In consideration of payment of the Licensee fee, which is a portion of the price you paid, 
Arturia, as Licensor, grants to you (hereinafter termed “Licensee”) a nonexclusive right to use 
this copy of the minimoog V program (hereinafter the “SOFTWARE”). 
 
All intellectual property rights in the software belong to Arturia SA (hereinafter: “Arturia”). 
Arturia permits you only to copy, download, install and use the software in accordance with the 
terms and conditions of this Agreement.  
The product contains product activation for protection against unlawful copying. This system is 
known as Syncrosoft and permits a permanent use of the software only after the activation 
process has been totally completed. The software can be used only together with the 
Syncrosoft key (dongle) and/or the Soft-eLicenser; the OEM software can be used only 
following registration. 
Internet access is required for the activation process. The terms and conditions for use of the 
software by you, the end user appear below. By installing the software on your computer you 
agree to these terms and conditions. Please read the following text carefully in its entirety. If 
you do not approve these terms and conditions, you must not install this software. In this 
event give the product back to where you have purchased it (including all written material, the 
complete undamaged packing as well as the enclosed hardware) immediately but at the latest 
within 30 days in return for a refund of the purchase price.  
 
1. Software Ownership 

Arturia shall retain full and complete title to the SOFTWARE recorded on the enclosed disks and 
all subsequent copies of the SOFTWARE, regardless of the media or form on or in which the 
original disks or copies may exist. The License is not a sale of the original SOFTWARE. 
 
2. Grant of License 

Arturia grants you a non-exclusive license for the use of the software according to the terms 
and conditions of this Agreement. You may not lease, loan or sublicense the software. 
If the software is protected by the Syncrosoft key alone, you may install a license for the 
software on one or at most 3 computers which are in your possession. The software may be 
used only on one of the computers at the same time by using the Arturia key.  
If the software is protected by the Soft eLicenser (alone or together with the Arturia key) or 
has been sold to the first end user together with other software and/or hardware (hereinafter: 
"OEM software"), you may install and use a license for the software only on one computer 
which is in your possession. Purchasing a Syncrosoft key makes it easily possible to use the 
software on three computers if needs occur. 
The use of the software within a network is illegal where there is the possibility of a 
contemporaneous multiple use of the program.  
You are entitled to prepare a backup copy of the software which will not be used for purposes 
other than storage purposes.  
You shall have no further right or interest to use the software other than the limited rights as 
specified in this Agreement. Arturia reserves all rights not expressly granted. 
 
3. Activation of the Software 

Arturia may use a compulsory activation of the software and a compulsory registration of the 
OEM software for license control to protect the software against unlawful copying. If you do not 
accept the terms and conditions of this Agreement, the software will not work. 
In such a case the product including the software may only be returned within 30 days 
following acquisition of the product. Upon return a claim according to §11 shall not apply. 
 
4. Support, Upgrades and Updates after Product Registration 

You can only receive support, upgrades and updates following the personal product 
registration. Support is provided only for the current version and for the previous version 
during one year after publication of the new version. Arturia can modify and partly or 
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completely adjust the nature of the support (hotline, forum on the website etc.), upgrades and 
updates at any time. 
The product registration is possible during the activation process or at any time later through 
the Internet. In such a process you are asked to agree to the storage and use of your personal 
data (name, address, contact, email-address, and license data) for the purposes specified 
above. Arturia may also forward these data to engaged third parties, in particular distributors, 
for support purposes and for the verification of the upgrade or update right.  
 
5. License module (Syncrosoft Key and/or Soft eLicenser) 

Arturia uses a hardware device connected through the USB connection of a computer, the 
"Syncrosoft key" and/or a protection scheme, the "Soft eLicenser" for license control 
(hardware and/or software dongle). The Syncrosoft key and/or Soft eLicenser permanently 
saves the license information and regulates access to the software. If a Syncrosoft key is 
required for the use of the software, then the Syncrosoft key must be connected physically to 
the computer through the USB interface. 
For the activation of the software, updates or upgrades of the software the computer which is 
connected to the Arturia key and/or using the Soft eLicenser or using the OEM software must 
be connected to the server of SIA Syncrosoft through the Internet. If the product was 
delivered with the Syncrosoft key, the license information was already transferred to the 
Syncrosoft key. If the product was delivered with a product card (without the Syncrosoft key), 
the activation codes of the enclosed product card must be entered manually by the user upon 
installation and the license information must be exchanged with the server of SIA Syncrosoft. 
In the event of OEM software, the activation codes will be send to an email-address submitted 
by you during a registration and must be entered manually by the user upon installation and 
the license information must be exchanged with the server of SIA Syncrosoft. 
The reinstallation of the software - on the same or another computer - is permitted only in 
case the already installed software cannot be used any more (e.g. following deinstallation). If 
the software does not use a Syncrosoft key, the new activation codes may be obtained from 
the users online account for support created during the personal product registration. Further, 
the activation codes must be entered manually by the user upon installation and the license 
information must be exchanged with the server of SIA Syncrosoft. Arturia may require for the 
provision of further activation codes e.g. your proof of purchase (invoice, receipt) and a signed 
assurance by fax or letter stating your name, address and that the already installed software 
cannot be used any more.  
You can also use another computer other than the one on which the software is to be installed 
for the activation and transfer of license data to the Syncrosoft key, if the software is using a 
Syncrosoft key. However, in such a case a corresponding access software (Syncrosoft License 
Control Centre, “LCC”) must be installed on the computer connected to the Internet, which is 
subject to a separate licensing agreement. 
 
6. Defect and loss of the Syncrosoft key 

In the case of a defect or damage to the Syncrosoft key Arturia or a third party engaged by 
Arturia will check the Syncrosoft key. In the case of a legitimate claim the Syncrosoft key and 
the licenses included shall be replaced in return for a handling fee. The licenses will only be 
replaced provided that they are licenses issued by Arturia. Further claims against Arturia are 
excluded. 
Arturia assumes no liability or obligation if the Syncrosoft key is mislaid as a result of loss, 
theft or otherwise. Arturia reserves the right to block the licenses saved on the Syncrosoft key 
upon being notified by the registered user of the loss. The licenses saved on the Syncrosoft 
key cannot be replaced.  
 
7. No Unbundling 

The software usually contains a variety of different files which in its configuration ensure the 
complete functionality of the software. The software may be used as one product only. It is not 
required that you use or install all components of the software. You must not arrange 
components of the software in a new way and develop a modified version of the software or a 
new product as a result. The configuration of the software may not be modified for the purpose 
of distribution, assignment or resale.  
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You may also not sell the Syncrosoft key separately as a license; the usage rights always 
remain with the software, in particular with the original software data carrier (e.g. CD). 
 
8. Assignment of Rights 
You may assign all your rights to use the software to another person subject to the conditions 
that (a) you assign to this other person (i) this Agreement and (ii) the software or hardware 
provided with the software, packed or preinstalled thereon, including all copies, upgrades, 
updates, backup copies and previous versions, which granted a right to an update or upgrade 
on this software, (b) you do not retain upgrades, updates, backup copies und previous 
versions of this software and (c) the recipient accepts the terms and conditions of this 
Agreement as well as other regulations pursuant to which you acquired a valid software 
license. 
A return of the product due to a failure to accept the terms and conditions of this Agreement, 
e.g. the product activation, shall not be possible following the assignment of rights. 
 
9. Upgrades und Updates 

You must have a valid license for the previous or more inferior version of the software in order 
to be allowed to use an upgrade or update for the software. Upon transferring this previous or 
more inferior version of the software to third parties the right to use the upgrade or update of 
the software shall expire. 
The acquisition of an upgrade or update does not in itself confer any right to use the software.  
The right of support for the previous or inferior version of the software expires upon the 
installation of an upgrade or update. 
 
10. Limited Warranty 

Arturia warrants that the disks on which the software is furnished to be free from defects in 
materials and workmanship under normal use for a period of thirty (30) days from the date of 
purchase. Your receipt shall be evidence of the date of purchase. Any implied warranties on 
the software are limited to thirty (30) days from the date of purchase. Some states do not 
allow limitations on duration of an implied warranty, so the above limitation may not apply to 
you. All programs and accompanying materials are provided “as is” without warranty of any 
kind. The complete risk as to the quality and performance of the programs is with you. Should 
the program prove defective, you assume the entire cost of all necessary servicing, repair or 
correction. 
 
11. Remedies 

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a) return 
of the purchase price or (b) replacement of the disk that does not meet the Limited Warranty 
and which is returned to Arturia with a copy of your receipt. This limited Warranty is void if 
failure of the software has resulted from accident, abuse, modification, or misapplication. Any 
replacement software will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer. 
 
12. No other Warranties 
The above warranties are in lieu of all other warranties, expressed or implied, including but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose. No 
oral or written information or advice given by Arturia, its dealers, distributors, agents or 
employees shall create a warranty or in any way increase the scope of this limited warranty. 
 
13. No Liability for Consequential Damages 

Neither Arturia nor anyone else involved in the creation, production, or delivery of this product 
shall be liable for any direct, indirect, consequential, or incidental damages arising out of the 
use of, or inability to use this product (including without limitation, damages for loss of 
business profits, business interruption, loss of business information and the like) even if Arturia 
was previously advised of the possibility of such damages. Some states do not allow limitations 
on the length of an implied warranty or the exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusions may not apply to you. This 
warranty gives you specific legal rights, and you may also have other rights which vary from 
state to state. 


